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RESUMEN 

La matriz extracelular (MEC) es una estructura tridimensional compuesta de proteínas fibrosas 

como colágena, fibronectina, elastina, laminina, entre otras moléculas, que regulan procesos 

vitales como la adhesión celular, preservación de tejidos y coordinación de señalizaciones 

bioquímicas; además, la MEC determina la plasticidad y especificidad celular en función de la 

composición y proporción de cada una de sus moléculas estructurales. En el hígado, las 

alteraciones en la composición y estructura de la MEC producen modificaciones en el 

microambiente celular, así como también en otras propiedades físicas como la rigidez o el módulo 

de elasticidad, que influyen en el desarrollo de enfermedades fibróticas que afectan la biología 

de las células hepáticas, principalmente a los hepatocitos. Dentro de este contexto, el objetivo de 

este trabajo fue elaborar una plataforma biomimética a partir de proteínas aisladas de matriz 

extracelular descelularizada (MECd) de hígados de rata para promover la adhesión y 

supervivencia de hepatocitos de cultivo primario. Para ello, se extrajeron hígados de rata Wistar 

y se descelularizaron por perfusión. Las MEC obtenidas se liofilizaron, pulverizaron, hidrolizaron 

enzimáticamente a distintos tiempos con pepsina y los productos se neutralizaron para obtener 

solamente la fracción de proteína soluble. Por otro lado, en vidrios funcionalizados, se elaboraron 

hidrogeles de poliacrilamida a 1 y 20 kPa conjugados con proteínas de MECd, colágena tipo I (Col 

I), membrana basal (MB) y proporciones 75/25 y 50/50 de Col I y MB, respectivamente, donde 

hepatocitos de cultivo primario fueron sembrados y evaluados durante 24 y 72 h. Los resultados 

obtenidos, mostraron interesantemente que los hepatocitos se adhieren preferentemente a los 

hidrogeles que contienen cualquiera de las concentraciones de Col I, pero no en los sustratos que 

contienen proteínas de MECd. Estos hallazgos sugieren que el colágeno fibrilar juega un papel 

importante en la adherencia y sobrevivencia de hepatocitos. No obstante, es necesario realizar 

mayor trabajo de investigación para encontrar la combinación ideal de proteínas de MECd y 

derivadas de MEC para generar plataformas de cultivo que promuevan la adherencia celular y 

mantengan el fenotipo de los hepatocitos. 
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ABSTRACT 

The extracellular matrix (ECM) is a three-dimensional structure composed of fibrous proteins such 

as collagen, fibronectin, elastin, laminin, among other molecules, which regulate vital processes 

such as cell adhesion, tissue preservation and coordination of biochemical signaling; furthermore, 

ECM determines cell plasticity and specificity based on the composition and ratio of each of its 

structural molecules. In the liver, alterations in the composition and structure of the ECM produce 

modifications in the cellular microenvironment, as well as in other physical properties such as 

rigidity or modulus of elasticity, which influence the development of fibrotic diseases that affect 

the biology of liver cells, mainly hepatocytes. Within this context, the aim of this experimental 

work was to develop a biomimetic scaffold with isolated proteins from rat livers to promote 

adhesion and survival of primary hepatocytes cultured. For this, Wistar rat livers were extracted 

and decellularized by perfusion. The decellularized extracellular matrix (dECM) obtained were 

lyophilized, pulverized, enzymatically hydrolyzed at different times with pepsin and the products 

were neutralized to obtain only the soluble protein fraction. On the other hand, in functionalized 

glasses, 1 and 20 kPa polyacrylamide hydrogels were made with dECM proteins conjugated, 

collagen type I (Col I), basement membrane (BM) and 75/25 and 50/50 ratios of Col I and BM, 

respectively, where primary hepatocytes culture were seeded and evaluated for 24 and 72 h. 

Interestingly, the results obtained showed that hepatocytes preferentially adhere to hydrogels 

containing any of the Col I concentrations, but not to substrates containing dECM proteins. These 

findings suggest that fibrillar collagen plays an important role in hepatocyte adherence and 

survival. However, more research is needed to find the ideal combination of dECM and ECM-

derived proteins to generate culture scaffolds that promote cell adherence and maintain the 

hepatocytes phenotype. 
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1. INTRODUCCIÓN 

La matriz extracelular (MEC) es una estructura tridimensional situada entre el intersticio de las 

células, compuesta de proteínas fibrosas como la colágena, fibronectina, elastina y laminina, y 

algunos polisacáridos como glucosamino y proteoglucanos que permiten regular procesos vitales 

como la adhesión celular, preservación de tejidos y coordinación de señalizaciones bioquímicas 

(Silvera et al., 2002; Porth et al., 2014). La plasticidad y especificidad celular, son otros de los 

procesos dependientes de la MEC, en función de la composición y proporción de cada uno de sus 

moléculas estructurales (Tomas et al., 2010; Porth et al., 2010).  

Interesantemente, la MEC hepática, por ejemplo, está compuesta principalmente por 

fibronectina, colágena tipo I y cantidades mínimas de colágena tipo III, IV, V y VI (Arvelo y Poupon, 

2001). Su integridad bioquímica y biomecánica, tienen gran importancia para el mantenimiento 

del fenotipo de los hepatocitos (células parenquimatosas), que constituyen alrededor del 80% de 

la masa total del hígado (Arias et al., 2001), así como de otras células como las no 

parenquimatosas (Martínez-Hernández y Amenta, 1995). Asimismo, las alteraciones en la 

composición y la estructura tridimensional de la MEC hepática producen modificaciones en el 

microambiente celular, desencadenando enfermedades crónicas como la cirrosis y la generación 

de tumores, que afectan evidentemente los tejidos y la biología de los hepatocitos (Rojkind et al., 

1980; Milani et al., 1990; Vracko, 1974). Dentro de los tratamientos para estos padecimientos 

generalmente incluyen el trasplante del órgano completo y la siembra de hepatocitos a través de 

la vena porta; sin embargo, estos suelen presentar incompatibilidad y una pérdida de la viabilidad 

temprana de las células, ocasionando solamente una solución temporal para el paciente, ya que 

una de las característica que resalta los cultivos in vitro de hepatocitos primarios es el cambio de 

su morfología, desdiferenciación y su transformación de células epiteliales a mesenquimales 

(Soto-Gutiérrez et al., 2011; Baptista, 2011).   

Diversos grupos de investigación se han encargado de crear nuevas tecnologías de cultivo que 

permiten generar un sistema biomimético para los distintos tipos celulares (Uygun et al., 2010; 

Azhim et al., 2011). Para los hepatocitos, la generación de plataformas de 2D y 3D, como los 

cultivos en placa con recubrimientos de hidrogel y cultivos en sándwich a partir de componentes 
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de MEC de hígados descelularizados, hacen interactuar las proteínas de la MEC con los receptores 

celulares y, por efecto, desencadenar una serie de transducción de señales que influyen en la 

diferenciación celular y en la conservación del fenotipo (Cukierman et al., 2001; Hynes et al., 

2002). Las distintas proteínas que integran la MEC regulan los mecanismos celulares en respuesta 

a estímulos ambientales, logrando la supervivencia celular, motilidad, migración, disposición del 

citoesqueleto y expresión génica (Legate et al., 2009). 

En los últimos años, se han intentado diseñar modelos in vitro que simulen el microambiente in 

vivo del órgano. Los andamios de MEC resultantes de la descelularización de tejidos hepáticos 

han mostrado ser excelentes para el crecimiento de múltiples tipos de células hepáticas al 

favorecer la conservación de sus actividades metabólicas (Wang et al., 2011; Soto-Gutierrez et 

al., 2011). Con ello se genera la posibilidad de ampliar las aplicaciones en la ingeniería de tejidos 

para la regeneración y/o trasplante de órganos, y para la realización de ensayos pre-clínicos ante 

las pruebas de nuevos fármacos y así estudiar una respuesta celular más cercana a la que se 

observa en el microambiente nativo (Crapo et al., 2012; Lee et al., 2014; Ware et al., 2017).  

Dada la importancia de los modelos biomiméticos para la realización de pruebas pre-clínicas de 

nuevos fármacos, surge la necesidad de generar plataformas de cultivo que mantengan el 

fenotipo de hepatocitos.  Para ello, en el presente trabajo de investigación, se pretende hacer uso 

de matrices extracelulares de hígados descelularizados de rata para implementar una técnica que 

permita incorporar proteínas de MEC en plataformas de hidrogel de rigidez controlada para el 

cultivo primario in vitro de hepatocitos y favorecer condiciones biológicas como la adhesión 

celular y la prolongación de la viabilidad. Asimismo, se espera evaluar el esparcimiento y 

agregación celular como respuesta antes las condiciones del cultivo.  
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2. ANTECEDENTES 

2.1 Hígado 

2.1.1 Anatomía y fisiología general 

El hígado, es un órgano con alta actividad metabólica (Byung-Soo et al., 2011). Participa 

primordialmente en el mantenimiento de la homeostasis y realiza otras funciones importantes 

como la regulación del volumen sanguíneo y de las vías de señalización endócrinas del 

crecimiento; metabolismo de ácidos grasos; síntesis de proteínas como la albúmina y factores de 

coagulación; producción de ácidos biliares, secreción de urea y almacenamiento de compuestos 

como el glucógeno, vitaminas (A y D) y algunos minerales como el hierro. Además, es el sitio 

principal donde se lleva a cabo la destoxificación o eliminación de xenobióticos y otros 

compuestos endógenos (Cascales, 2008; Trefts et al., 2017; Delgado y Mas, 2017). 

En los mamíferos, el hígado representa aproximadamente del 2 al 3% de la masa corporal 

(Bismuto et al., 1982). A nivel macroscópico, consta de cuatro compartimentos denominados 

lóbulos y cada uno realiza funciones independientes; por otra parte, el lobulillo hepático es la 

organización microscópica del hígado considerada como la unidad estructural y funcional de este 

órgano (Delgado y Mas, 2017).  

El lobulillo hepático tiene una forma hexagonal o poligonal que consta de un sistema vascular 

denominado tríada portal, conformado por la arteria hepática, vena portal y un conducto biliar, 

tal como se muestra en la Figura 1. A su vez, el flujo sanguíneo, así como productos metabolizados 

provenientes de la arteria hepática y la vena portal, son transportados hacia la vena central 

(situada en la zona central del lobulillo) para ser posteriormente distribuidos a otros órganos 

(Colnot y Perret, 2011; Krishna, 2013).  

La tríada portal se encuentra dividida en 3 segmentos funcional y bioquímicamente diferentes: 

las zonas periportal, lobular central y perivenosa (Krishna, 2013). Cada zona contiene poblaciones 

heterogéneas de células altamente especializadas con plasticidad funcional definida que les 

permiten realizar procesos metabólicos de manera simultánea para mantener la homeostasis del 
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organismo, en función de los gradientes de concentración distintos de oxígeno, nutrientes, 

hormonas y productos de desecho que circulan a través de la sangre (Colnot y Perret, 2011; Trefts 

et al., 2017).  

 

 

 

 

 

 

 

 

 

 

 

A este fraccionamiento de funciones se conoce como zonación metabólica (Kietzmann, 1996; 

Colnot y Perret, 2011). No obstante, con relación a procesos moleculares, se han llevado a cabo 

investigaciones donde han demostrado que son varios los mecanismos involucrados en la 

zonación del hígado. Entre ellos, el factor de transcripción nuclear del hepatocito alfa (HNF) 

(Colnot y Perret, 2011) en coordinación con la vía de señalización de Wnt/β-catenina, han sido 

considerados recientemente como los impulsores principales para la zonación hepática 

(Kietzmann, 2017; Tomlinson et al., 2019).  

Figura 1. Estructura tridimensional del lóbulo hepático. El lóbulo hepático consiste en una organización 

de distintos componentes celulares, a partir de la vena central de la zona centro lobular, limitada en 

cada extremo por la tríada portal que consiste en la vena porta, la arteria hepática y un conducto biliar 

(Imagen obtenida y modificada de Adams et al., 2006). 
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Otra de las características más destacables del hígado, es su capacidad de regeneración de una 

manera coordinada por todos los tipos celulares para restaurar su masa y volumen original 

después de una resección quirúrgica (hepatectomía) parcial o por un daño inducido por 

xenobióticos, toxinas o virus (Anti et al., 1994; Berasain et al., 2015; Michalopoulos, 2016). Se ha 

evidenciado que, posterior a la inducción de sustancias hepatotóxicas, como el tetracloruro de 

carbono, el proceso de regeneración ocurre en respuesta a la inflamación y al estrés oxidativo a 

través de diferentes mecanismos moleculares en las vías de señalización que regulan la 

proliferación celular  (García-Trevijano et al., 2002; Bhat et al., 2019; Huck et al., 2019), así como 

también los distintos cambios epigenéticos que regulan la activación e inactivación de genes 

involucrados durante la regeneración (Arechederra et al., 2019). 

2.1.2 Células hepáticas 

El hígado está compuesto por diversos tipos celulares de diferente origen embriológico. Estas 

células altamente diferenciadas incluyen a los hepatocitos o células parenquimatosas, células 

epiteliales biliares (también llamados colangiocitos), células estrelladas, células de Kupffer y 

células endoteliales sinusoidales (Trefts et al., 2017). Cada tipo celular tiene una función 

particular; no obstante, dentro del lobulillo hepático, las funciones de las células actúan de 

manera cooperativa para el mantenimiento de la homeostasis metabólica. Particularmente los 

hepatocitos, son las células que mayoritariamente componen al tejido hepático (alrededor del 

80-85% de la masa celular) y por lo tanto, las que realizan gran parte de las funciones del órgano 

(Valatas et al., 2003; Trefts et al., 2017) e influyen de manera significativa en la fisiopatología del 

hígado (Zakim y Boyer, 1993).  

Las funciones principales de los hepatocitos se encuentran resumidas en la Tabla 1, con base a las 

aportaciones realizadas por Schiff y Schiff (1993) y Zakim y Boyer (1996). 

Los hepatocitos miden alrededor de 20 a 30 μm; poseen núcleos redondeados y algunas son 

binucleadas (Kmiec et al., 2001). La particularidad que presentan estas células es la función 

especializada que va a depender de su localización y distribución a lo largo de las tríadas portales 

del lobulillo hepático, pues se ha demostrado que son las que primordialmente zonifican al hígado 

(Katz et al., 1977; Stanger, 2015). En el lobulillo, los hepatocitos se encuentran organizados en 
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placas o láminas ordenadas, que a su vez, forman conductos o espacios vasculares denominados 

sinusoides (ver Figura 1). A través de ellos circula el oxígeno y los nutrientes de la sangre 

provenientes de la arteria hepática y vena porta, respectivamente (Delgado y Mas, 2017; Trefts 

et al., 2017). 

Los sinusoides se encuentran conformados por las células endoteliales sinusoidales (de ahí se 

deriva su nombre), formando fenestraciones que permiten el paso de moléculas de elevada masa 

molecular como proteínas y quilomicrones (Cascales, 2008). Además, dentro de los sinusoides 

también se encuentran las células epiteliales biliares, células de Kupffer y células estrelladas 

(Delgado y Mas, 2017). Por lo tanto, estas estructuras sinusoidales son las que permiten que los 

hepatocitos tengan acceso a la sangre circulante (Cascales, 2008). Los sinusoides se encuentran 

separados de los hepatocitos a través de un espacio perisinusoidal llamado espacio de Disse 

(Schmid, 1991) y se encarga del intercambio de nutrientes y de la comunicación con los otros 

tipos celulares a través de señalizaciones autócrinas y parácrinas (Delgado y Mas, 2017). 

Tabla 1. Funciones principales de los hepatocitos 

Actividad Ejemplos 

Producción de proteínas trasportadoras del 

plasma sanguíneo 

Albúmina, ceruloplasmina, transferrina y 

lipoproteínas. 

Producción de inhibidores de proteasas α1-antitripsina, antitrombina y α2-macroglobulina. 

Generación de factores de coagulación 

sanguínea 

Fibrinógeno, protrombina y factores V, VII, IX, X, 

entre otros.  

Producción de complejos de inmunidad e 

inflamación 
Complemento C3 y proteína C reactiva.  

Control de la homeostasis de moléculas 

energéticas 

Glucosa, glucógeno y ácidos grasos, entre algunos 

derivados como los triglicéridos, colesterol, ácidos 

biliares, vitaminas A y D. 

Metabolismo de moléculas 
Aminoácidos, urea, metales como el hierro y cobre; 

bilirrubina y hemo A.  

Destoxificación de xenobióticos 

Solventes orgánicos, pesticidas, herbicidas, toxinas 

provenientes de plantas, animales y hongos, 

drogas y fármacos.  

Nota. Información recopilada de Schiff y Schiff, (1993); Zakim y Boyer, (1996). 
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2.1.3 Matriz extracelular (MEC)  

La matriz extracelular (MEC) es un sistema dinámico (Huxley-Jones et al., 2008) formado por una 

red tridimensional constituida de macromoléculas en el espacio intersticial celular, cumple 

funciones vitales e indispensables como la multiplicación celular, mantenimiento de la 

homeostasis, preservación fenotípica, procesos bioquímicos y de señalización (Figura 2). De 

manera general, los principales componentes de una MEC son las colágenas de tipo I, III, IV, VII 

(Rubin et al., 2006), fibronectina, laminina, integrinas (Schalper et al., 2003) que confieren 

estructura, flexibilidad, adherencia celular (Qin et al., 2004; Timpl et al., 2006), la unión con otras 

células circundantes y promueven los procesos de señalización (Aumailley y Smyth, 1998; Heino, 

2007); también se encuentran moléculas como los proteoglucanos, con alta capacidad de 

retención de agua proporcionan turgencia y estabilidad a la MEC, y almacenan factores de 

crecimiento y citocinas (Bosman y Stamenkovic, 2003); glucoproteínas especializadas (Scott, 

2005), elastina, entactina, fibrilinas, receptores de membrana, factores de crecimiento, 

glucosaminoglucanos y metaloproteinasas (Eynard y Mirta, 2008). En conjunto, estas moléculas 

de MEC interactúan directamente con los receptores de la superficie celular para regular la 

actividad de las células a través de vías de señalización (Zaachigna et al., 2006). 

Otro punto importante de la MEC es su finalidad para determinar la especificidad tisular, es decir, 

su cantidad y composición llevan a la formación de un tipo de tejido y funciones particulares 

(Tomas et al., 2010; Porth et al., 2014). 

2.1.4 Composición bioquímica de la MEC hepática  

De manera concreta, la MEC hepática está compuesta principalmente por fibronectina, colágena 

tipo I y cantidades mínimas de colágena tipo III, IV, V y VI (Arvelo et al., 2001) que se distribuyen 

de distinta manera en el órgano: las colágenas I, III y VI están presentes en el exterior del hígado 

formando una capa fibrosa junto con otras células mesoteliales en el intersticio de las tríadas 

portales, las venas centrales y como recubrimientos delgados en el espacio de Disse, aunque en 

este último, abundan más las tipo III y VI (Martinez-Hernandez, 1984). Estas colágenas (I, III y VI) 

denominadas como fibrilares contienen estructuras rígidas de aminoácidos en forma de una triple 
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hélice, conformadas a su vez por haces de fibras heterogéneas que le proporcionan las 

propiedades mecánicas al hígado (Rodés, 2007).  

La colágena tipo IV es una proteína no fibrilar conformada por cadenas de péptidos en triple 

hélice, intercaladas a su vez con fragmentos de proteínas lamininas que le proporcionan 

flexibilidad molecular (Xu et al., 2018). Es una de las proteínas más abundantes de la membrana 

basal y es secretado principalmente por las células endoteliales (Rodés, 2007). En el lobulillo 

hepático, se encuentra predominantemente distribuido en el espacio de Disse principalmente en 

los sinusoides, estructuras vasculares, musculares, mesoteliales, neurales y epiteliales (Martinez-

Hernandez, 1984). 

Finalmente, la fibronectina rodea la superficie de la vasculatura en el intersticio de las tríadas 

portales de manera discontinua en el espacio de Disse, y cuando el hígado se encuentra en 

regeneración, esta proteína rodea las venas centrales (Sell y Ruoslahti, 1982). 

 

 

 

 

 

 

 

 

 

 

Figura 2. Matriz extracelular. Representación esquemática de los componentes principales de la matriz 

extracelular en su forma tridimensional, el cual tiene interacción con los receptores y proteínas 

transmembranales de la célula (Imagen realizada en Biorender, 2020). 
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La integridad bioquímica y biomecánica de la MEC hepática tienen gran importancia para el 

mantenimiento del fenotipo de los hepatocitos, así como de los otros tipos celulares (Martinez-

Hernandez y Amenta, 1993), pues las células tienen la capacidad de detectar cambios en las 

propiedades mecánicas de la MEC que pueden afectar sus vías de señalización (Pelham et al., 

1998). Estudios han encontrado diferencias significativas en las vías de señalización de las células 

cultivadas en modelos de cultivos in vitro de hepatocitos, donde su fenotipo, evidentemente 

depende de la naturaleza de la MEC donde se cultiva (Rojkind et al., 1980; Geiger et al., 2001; Lee 

et al., 2013). En los sistemas in vivo, las alteraciones en la composición y la estructura 

tridimensional de la MEC hepática ocasionan la formación de tejido cicratricial conocido como 

fibrosis, hasta llegar a la generación del último estadio conocido como cirrosis, que afectan el 

microambiente de los tejidos y la biología de los hepatocitos (Rojkind et al., 1979; Schuppan et 

al., 1990; Arvelo et al., 2001).  

En análisis proteómicos de hígados de rata realizados por Goddard et al., (2016), a través de 

cromatografía líquida acoplada a espectrometría de masas (LC-MS/MS), se lograron determinar 

las proporciones de proteínas pertenecientes a MEC, mismas que corresponden a un 44%, 

seguido de un 26.4% de colágenos fibrilares, 15.3% de otros colágenos fibrilares y estructurales, 

y aproximadamente 10% de proteínas de membrana basal (Figura 3a). De este total de proteínas, 

se destaca que el colágeno tipo I, es la más abundante. Asimismo, dentro de la proporción de 

proteínas de MEC, se determinaron las veinte más abundantes, distintas a colágena tipo I (Figura 

3b). 
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Figura 3: Análisis proteómico de MEC de hígado de rata. a) Proporción de proteínas de MEC y otras 

asociadas a MEC; b) veinte proteínas más abundantes de MEC de hígados de rata y c) veinte proteínas 

más abundantes de MEC distintas a colágeno tipo I (versión modificada de Goddard et al., 2016). 
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El conocimiento de la composición y cuantificación de proteínas de MEC ha tenido gran 

aplicabilidad en estudios e investigaciones relacionados con la ingeniería de tejidos y de 

biomateriales, con la finalidad de esclarecer las respuestas a diferentes estímulos de diversos 

tipos celulares para ensayos de tratamientos a enfermedades, biología de células madre, 

regeneración de tejidos y prueba pre-clínicas de nuevos fármacos.  

2.1.5 La mecánica y la rigidez en el microambiente hepático  

Las propiedades mecánicas de la MEC afectan evidentemente el comportamiento de las células, 

y los cambios en la estructura de la MEC ocurridos por algún daño impactan de manera 

significativa las funciones de un órgano o tejido, pudiendo generar como resultado el desarrollo 

de enfermedades degenerativas (Kim et al., 2000; Parker et al., 2014; Klaas et al., 2016). 

Todas las células del cuerpo humano se encuentran susceptibles a cambios de fuerza física como 

la tensión, compresión, presión de flujo sanguíneo, esfuerzo cortante, fuerzas mecánicas estáticas 

y la gravedad (Wells, 2008). Cada una de ellas son percibidas a través de mecanorreceptores 

localizados en la superficie de la membrana plasmática que interactúan directamente con la MEC. 

Estas interacciones generan estímulos que convierten las señales mecánicas en señales 

bioquímicas que desencadenan una respuesta celular a través de vías de señalización (You et al., 

2018). Este proceso es conocido como mecanotransducción. Las señales de fuerza del exterior 

son transmitidas al interior de la célula en cooperatividad con diversos complejos celulares como 

receptores mecanosensores de membrana (adhesiones focales, integrinas de unión, cadherinas, 

moléculas de adhesión celular, canales iónicos activados por estiramiento, receptores de tirosina 

quinasa, etc.), complejos de proteínas asociados y mecanotransductores como la red 

citoesquelética (Lim et al., 2018). La red del citoesqueleto está conformada por los 

microfilamentos de actina, microtúbulos y los filamentos intermedios; forman una estructura 

dinámica que une la membrana con el núcleo celular, y que además le confieren estabilidad y 

resistencia a los tejidos ante la deformación celular. Por su parte, los filamentos de actina se 

acoplan a complejos de adhesiones focales mediante las proteínas talina, vinculina o α-catenina, 

influyendo en la contractilidad y tensión citoesquelética, aumentando las fuerzas mecánicas y de 

adherencia. En conjunto, estas moléculas perciben los cambios de fuerzas y promueven la 
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participación de proteínas que amplifican y transmiten las fuerzas para su conversión en señales 

bioquímicas (Mathieu, 2019; Kang, 2020).  

Durante una lesión hepática, las células y la MEC generan cambios en la microestructura del tejido 

hepático y la circulación sanguínea, conllevando a la modificación de las propiedades mecánicas 

del hígado en términos de rigidez, esfuerzo cortante y presión intersticial (Eipel  et al., 2010). El 

módulo elástico (E) y el módulo cortante (G) son dos unidades principales de rigidez (Venkatesh 

y Ehma, 2014), cuyos valores en el microambiente mecánico del hígado están co-relacionado con 

los diferentes estadios de las patologías hepáticas con base a estudios confirmados (Figura 4) 

(Castera et al., 2008; Baiocchini et al., 2016). Los hígados fibróticos son más rígidos que el hígado 

sano o normal, debido a una elevada deposición y reticulación de MEC durante el proceso de 

fibrogénesis (Iwakiri, 2014). 

 

 

 

 

 

 

 

 

En los cultivos celulares para el modelo de enfermedades, los hepatocitos han sido el principal 

tipo celular utilizado para evaluar los efectos que producen los cambios en la rigidez. En cultivos 

primarios de hepatocitos se ha demostrado que en sustratos rígidos o blandos (representando 

entornos fibróticos y no fibróticos, respectivamente), las células presentan fenotipos totalmente 

diferentes. En los sustratos blandos las células permanecen diferenciadas y el tamaño celular se 

F1 F2 F3 F4 Estadio 

fibrótico 

2.5 kPa 7 kPa 9.5 kPa 12.5 kPa 75 kPa 

Col I 

Col III 

Elastina 

Col IV 

Acumulación 

de proteínas 

de MEC 

Figura 4. Módulo de elasticidad (E) del hígado en diferentes estadios fibróticos. Representación 

esquemática de la co-relación del módulo elástico (en kPa) y el estadio fibrótico del hígado. Durante la 

progresión de la fibrosis se refleja la abundancia de las principales proteínas de MEC involucradas 

(Adaptado de Castera et al., 2008; Baiocchini et al., 2016). 
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observa constante; por el contrario, en los sustratos rígidos, las células se extienden y proliferan 

(Hansen et al., 2006). También, se ha observado que los niveles de mRNA de albúmina se reducen 

significativamente ante el aumento de la rigidez. De este modo se concluye que los 

microambientes rígidos pueden conducir a una desdiferenciación celular de los hepatocitos 

(Görtzen et al., 2015; Desai et al., 2016).  

El entendimiento de las vías de señalización por mecanotransducción y su influencia en el 

comportamiento celular podría ayudar a la construcción de sistemas biomiméticos que permitan 

simular el entorno y la homeostasis de un microambiente hepático. De este modo se generarían 

métodos más confiables para la generación de modelos de enfermedades hepáticas o para 

estudios de respuesta celular ante ensayos de nuevos fármacos. 

2.2 Descelularización de tejidos y órganos 

La descelularización es un proceso que consiste en la eliminación total del material celular de los 

órganos o tejidos, con la finalidad de obtener MEC, cuyas propiedades bioquímicas y mecánicas 

sean preservadas (Lee, 2014). En su mayoría, estos procedimientos son orientados a la generación 

de biomateriales para mejorar las condiciones de los cultivos celulares. 

Las investigaciones pioneras en la generación de MEC de tejidos tuvieron sus orígenes en la 

década de los ochenta (Hjelle et al., 1979; Rojkind et al., 1980). Más tarde, a mediados de la 

década de los noventa, Badylak et al., (1995), generaron MEC de submucosa intestinal 

descelularizada a través de métodos mecánicos para conservar únicamente las capas de tejido 

conectivo. Posteriormente, el mejoramiento de los protocolos de descelularización, permitió 

obtener MEC de tejidos simples de piel (Chen et al., 2004), tejido vascular (Schmidt et al., 2000), 

válvulas cardíacas (Elkins et al., 2001), vejiga (Schultheiss et al., 2005), hasta órganos más 

complejos como el hígado (Gilbert et al., 2006) y corazón (Mazza et al., 2015), mostrando 

resultados comprometedores que conllevarían a su utilización en el área biomédica y de 

ingeniería de tejidos. Estos acontecimientos destacados se encuentran resumidos en la Figura 5. 

Las funciones de los órganos se encuentran directamente relacionados con la composición 

bioquímica y propiedades biofísicas de las MEC, y esto ha determinado el motivo por el cual las 
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células de un órgano específico muestran una preferencia innata hacia los biomateriales de MEC 

descelularizadas del órgano de origen (Cortiella et al., 2010). Este argumento fue demostrado 

experimentalmente por Nakayama et al., (2013) al recelularizar con células madre embrionarias 

humanas, MEC descelularizadas de riñón y pulmón de mono Rhesus (Macaca mulatta). Las células 

madre lograron diferenciarse a células renales y pulmonares, respectivamente, presentando 

características morfológicas propias de cada tipo celular; además, los niveles de expresión génica 

de los genes asociados a los órganos aumentaron significativamente en el tiempo de cultivo.  

Los análisis proteómicos de las MEC de riñón y pulmón, revelaron entre sí variaciones entre las 

proporciones de proteínas, por lo que probablemente, estas combinaciones junto con otros 

factores de crecimiento residuales y moléculas solubles permanecidos en las MEC 

descelularizadas, sean responsables de llevar a cabo la diferenciación y la organización de las 

células (Nakayama et al., 2013). La explicación más cercana que sostiene estos fenómenos es 

debido a que las proteínas específicas de las MEC se distribuyen de manera muy distintiva a través 

de los compartimentos del órgano, quedando como ‘huellas’ para las células que llegasen a residir 

(Luque et al., 2013).  

Las MEC descelularizadas de tejidos y órganos ofrecen múltiples ventajas para la fabricación de 

biomateriales: 

i. Preservación de la estructura y composición ante una organización y remodelación de los 

tejidos (Badylak et al., 2011; Song et al., 2011). 

ii. Las propiedades fisicoquímicas de las MEC regulan los procesos de migración y 

diferenciación celular (Cortiella et al., 2010; Nakayama et al., 2013; Garreta, 20161). 

iii. Durante la realización de un trasplante, no se genera rechazo o incompatibilidad por el 

sistema inmune debido a la conservación de los componentes de las MEC (Bernard et al., 

1983; Chung et al., 2006). 

iv. Conservan las propiedades biomecánicas de manera muy similar al tejido nativo (Ott et 

al., 2008; Luque et al., 2013).  

v. Promueven una respuesta constructiva de remodelación en una variedad de tejidos para 

la realización de estudios pre-clínicos y clínicos (Londono et al., 2015; Badylak et al., 2016).  
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vi. Garantiza el mantenimiento de las funciones celulares, así como la conservación del 

fenotipo (Bissell et al., 1987; Cortiella et al., 2010).  

  

 

 

 

 

 

 

 

 

 

 

 

2.2.2 Técnicas de descelularización  

Los protocolos de descelularización óptimos generan MEC libres de componentes celulares y 

material genético (ADN y ARN) en un tiempo determinado que dependerá de la naturaleza del 

tejido u órgano y, por supuesto, de la técnica empleada. Con base a ello, se pretenden obtener 

MEC cuyas propiedades bioquímicas, estructurales y mecánicas sean conservadas (Montoy et al., 

2009; Sawada et al., 2008).  

Técnicas como la perfusión y de inmersión/agitación han sido principalmente utilizadas para los 

procesos de descelularización; sin embargo, existen otras técnicas como por gradiente de presión 

Figura 5. Línea del tiempo de estudios basados en órganos descelularizados. En el esquema se 
representan las investigaciones con tejidos y órganos descelularizados más destacadas y pioneras las 
últimas 4 décadas. 

Biosíntesis de la matriz de la membrana basal por 

glomérulos renales de rata aislados (Hjelle et al., 

1979). 

1970 

1980 Biomatriz de tejido conectivo para cultivos a 

largo plazo de hepatocitos de rata normales 

(Rojkind et al., 1980). 

2000 

Generación de matrices de submucosa intestinal de 

cerdo para la reparación de tendones en modelos 

caninos (Badylac et al., 1995). Descelularización de tejidos simples: piel, tejido 

vascular, válvulas de corazón y vejiga (Chen, 

2004; Schmidt, 2000; Elkins, 2001; Schultheiss, 

2005).  
2008 

Por primera vez, descelularización completa del 

corazón de ratón (Ott et al., 2008). 

2013 Descelularización completa de riñón y pulmones 

de humano (Orlando et al., 2013; Nichols et al., 

2013). 
2015 Descelularización completa de corazón e hígado 

humano (Sánchez et al., 2015; Mazza et al., 

2015). 

Línea del tiempo 
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(Montoya et al., 2009), fluido supercrítico (Sawada et al., 2008), lavados por soluciones hipo e 

hipertónicas (Dahl et al., 2003), digestión enzimática con proteasas y nucleasas (Woods y Gratzer, 

2005; Bader et al., 1998), sonicación (Fitzpatrick et al., 2010), entre otros. 

2.2.3 Perfusión 

La descelularización por perfusión es comúnmente utilizada en órganos que presenten una 

estructura vascular ramificada y definida, para que los componentes y soluciones 

descelularizantes puedan ser distribuidos a través de la vasculatura de manera homogénea por 

todo el órgano. Esta técnica ha sido empleada en órganos como corazón e hígado, donde su 

arteria o vena principal pueden ser canuladas para perfundir soluciones de descelularización bajo 

condiciones fisiológicas (Ott et al., 2008). Generalmente, los protocolos de descelularización por 

perfusión se basan en el uso de detergentes iónicos y no iónicos como el dodecil sulfato de sodio 

(SDS) y Tritón X-100, respectivamente. El SDS se encarga de eliminar la mayoría de los 

componentes celulares al desnaturalizar algunas moléculas de las membranas citoplasmáticas y 

nucleares (Rieder et al., 2004; Woods y Gratzer, 2005). Asimismo, Shupe et al., (2010), lograron 

generar el primer protocolo de descelularización de hígados de ratones empleando SDS, el cual 

permitió eliminar cualquier componente celular, específicamente ADN. 

El Tritón X-100 es el agente más utilizado para la descelularización de hígados (Nari et al., 2013). 

Y aunque todavía su función no está muy clara, se ha demostrado en trabajos previos su 

capacidad de eliminar residuos celulares y nucleares (Dahl et al., 2003; Grauss et al., 2005). A 

diferencia del SDS, el Tritón X-100 conserva la integridad de las colágenas de la MEC (Guyette et 

al., 2014). Las formulaciones para la descelularización también se ven complementadas con 

enzimas como la tripsina y nucleasas para una mejor extracción de ADN/ARN (Soto-Gutierrez, 

2011), hidróxido de amonio (Baptista et al., 2011) y agentes quelantes como EDTA (ácido 

etilendiaminotetraacético) y EGTA (ácido aminopolicarboxílico) (De Kock et al., 2011).    
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2.2.4 Inmersión/agitación  

La descelularización por medio de la técnica de inmersión/agitación se logra mediante la 

sumersión de tejidos en fragmentos pequeños en soluciones descelularizantes mientras se 

somete a agitación mecánica. Por lo regular, se realiza cuando los órganos carecen de una 

vasculatura o el acceso a estas estructuras es difícil; a diferencia de la perfusión, esta técnica 

requiere de un mayor tiempo de proceso para la descelularización (Garreta et al., 2017).  

Existen dos tipos de agitación: la directa e indirecta. La primera, consiste en el uso de un agitador 

orbital para la remoción celular de tejidos sumergidos en las soluciones descelularizantes 

(Meezan et al., 1975). Por otro lado, la sonicación es una agitación mecánica indirecta que 

ocasiona daño celular a causa de las ondas sonoras (Fitzpatrick et al., 2005); no obstante, no logra 

ser suficiente este paso para una descelularización completa del tejido (Takami et al., 2005; Hung 

et al., 2013), es por ello que esta técnica deber ser complementado con agentes químicos.  

2.3 Cultivo celulares biomiméticos 

Los cultivos celulares biomiméticos son sistemas que proporcionan un microambiente óptimo 

que permite mejorar y mantener las actividades metabólicas de la célula. En este sentido, es 

necesario el uso de sistemas de andamiaje o biomateriales, como soportes o sustratos que 

contengan las características físicas y fisiológicas cercanos a los modelos in vivo; de este modo, 

se llevarán a cabo estímulos celulares que permitirá generar una respuesta a través de vías de 

señalización, regulando procesos de proliferación y diferenciación (Lanza et al., 2011; Ijima et al., 

2019). En otras palabras, los andamios tienen el objetivo de imitar el medio biológico y 

fisicoquímico de una MEC natural, ejerciendo como un sustrato de adhesión de las células 

cultivadas, para proveer un soporte mecánico temporal y dirigir la diferenciación o mantener el 

fenotipo celular (Yeong et al. 2004). 

Evidencias experimentales han mostrado que en los sistemas de andamiaje, la rigidez o módulo 

de elasticidad es una de las propiedades mecánicas que tienen gran influencia en el 

comportamiento celular, en conjunto con otras propiedades bioquímicas. En los sistemas in vivo, 

cambios en la rigidez del órgano o tejido están estrechamente relacionados con la fibrosis, el 
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cáncer y algunas enfermedades (Pelham y Wang, 1997; Yeung et al., 2005). Por tal motivo, se 

intentan diseñar plataformas de cultivo cuyas características mecánicas sean controlables en 

función de la MEC que se requiera biomimetizar, ya que la mayoría de los modelos biológicos de 

cultivo in vitro tradicionales, se basan en el uso de sustratos planos y rígidos como vidrio 

(cubreobjetos) o plástico (cajas de cultivo de poliestireno), donde sus propiedades mecánicas se 

encuentran alejadas de las condiciones fisiológicas de los tejidos (Yeung et al., 2005), conllevando 

a destacables cambios en el comportamiento celular como morfología aplanada, polarización 

anormal, proliferación, adhesión y pérdida del fenotipo diferenciado (Pelham y Wang, 1997; 

Engler et al., 2004b; Reinhart-King et al., 2005; Khatiwala et al., 2006; Baker y Chen, 2012). 

2.3.1 Hidrogeles en cultivo celular 

Existe una amplia diversidad de materiales para la construcción de andamios, cuyas 

características fisicoquímicas como la geometría, propiedades de superficie (ejemplos 

visualizados en la Figura 6), porosidad, tamaño de poro, densidad, tamaño de fibras, fuerzas de 

tensión mecánicas y biocompatibilidad, influyen de manera importante en la adhesión celular y 

proliferación (Boyan et al., 1996). Cumpliendo con algunas características anteriormente 

mencionadas, los hidrogeles se han convertido en una alternativa prometedora para el cultivo 

celular debido a la estrecha semejanza con la MEC nativa (Liaw et al., 2018), su capacidad de 

adhesión celular y retención de proteínas (Tibbitt y Anseth, 2009), además de poseer propiedades 

mecánicas y bioquímicas interesantes para múltiples aplicaciones en el área biomédica y 

biotecnológica (Cruz-Acuña y García, 2016).  
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Los hidrogeles son materiales poliméricos altamente hidratados, con un contenido de agua mayor  

a 30% en peso, conformados por redes reticuladas de las cadenas poliméricas en presencia de 

agua o medio fisiológico, otorgándoles una organización estructural tridimensional, formado a su 

vez por interacciones físicas o por interacciones químicas entre los grupos funcionales presentes 

(Peppas, 1986; Peppas, 1996; Hoffman, 2002; Drury, 2003; Klouda, 2008). Las cadenas poliméricas 

que conforman los hidrogeles pueden ser de origen natural o sintético. Dentro de los naturales 

se encuentran colágena (Wallace y Rosenblatt, 2003), fibrina (Eyrich et al., 2007), alginato (Kong 

et al., 2003), ácido hialurónico (Solchaga et al., 2002), gelatina (Kim et al., 2004) y quitosano (Suh 

y Matthew, 2000); los polímeros de origen sintético se encuentran copolímeros como fumarato 

de propileno (PPF) (Behravesh y Mikos, 2003), polietilenglicol (PEG), polivinil alcohol (PVA) 

(Bryant et al., 2004) y poliacrilamida (PA) (Tse y Engler, 2010). 

2.3.1.1 Hidrogeles de colágena 

La colágena es una de las proteínas que principalmente conforma a los tejidos; particularmente 

la colágena tipo I es la más común y el principal componente estructural de muchos tejidos 

(Shoulders y Raines, 2009). Debido a esto, resulta ser un material muy un atractivo para los 

modelos en cultivos celulares. Los principales materiales consisten en hidrogeles de colágena tipo 

I, pero también se incluyen los tipos II y III. Para la obtención de la colágena tipo I para la 

elaboración de los hidrogeles, generalmente se derivan del tendón de cola de rata y 

a) b) c) 

Figura 6. Microscopías electrónicas de estructuras tridimensionales de MEC. Imágenes 
representativas de las nanoestructuras de a) fibras de colágena de un hidrogel de colágena tipo I, b) 
Matrigel® y c) MEC de hígado de rata con la presencia de fibras de colágena. Claramente, se logra 
apreciar la arquitectura particular de cada biomaterial. Imágenes obtenidas de Safer et al.,(2015); 
Poincloux et al., (2009). 



 
 

 35 

posteriormente, se lleva a cabo una solubilización con pepsina o ácido; sin embargo, actualmente 

los hidrogeles de colágena tipo I se pueden encontrar disponibles con una gran variedad de 

proveedores (Caliari y Burdick, 2016). 

Por representar uno de los principales componentes de la MEC, los hidrogeles de colágena tipo I 

ofrecen la ventaja de generar un microambiente biomimético para las células, pues son ideales 

para la adhesión celular y presentan un entorno viscoelástico similar al nativo; por el contrario, la 

desventaja que disponen es la baja rigidez, disminución de la estabilidad a largo plazo y su 

variación entre lotes. Las propiedades mecánicas de los hidrogeles se determinan en función de 

la concentración de colágena; la elaboración de hidrogeles > 1kPa, implica dificultades al 

ocasionar un grado de reticulación extenso, generando así la degradabilidad de las fibras de 

colágena. Asimismo, han reflejado cambios en la accesibilidad de los ligandos de adhesión celular, 

viéndose limitado su control y uso. A pesar de ello, los hidrogeles de colágena tipo I al menos han 

evidenciado ser excelentes modelos en los cultivos in vitro durante los procesos de migración 

celular (Kim et al., 2008; Doyle et al., 2015).  

2.3.1.2 Hidrogeles de Matrigel 

Además de los hidrogeles de colágena tipo I, existen otros hidrogeles derivados de MEC y que 

también contienen colágena en su composición. Matrigel® es una preparación de proteínas 

extraídas de membrana basal de tumores de sarcoma de ratón Engelbreth-Holm-Swarm (EHS), 

compuesta principalmente de laminina (~60%), colágena tipo IV (~30%), entactina (~8%), 

proteoglicanos de sulfato de heparán, perlecano (~2-3%) (Corning, 2019) y factores de 

crecimiento (Kleinman y Martin, 2005). Matrigel ha sido protagonista de múltiples investigaciones 

en diversos tipos celulares y ha demostrado ser una herramienta práctica y útil; se han utilizado 

para cultivar y expandir células pluripotenciales humanas (hPSC) (Xu et al., 2001), neuronas 

(Quian y Saltzman, 2004; Lee et al., 2015), cardiomiocitos (Laflamme et al., 2007) y hepatocitos 

(Sellaro et al., 2010). Además, los recubrimientos de Matrigel ante los modelos de tubulogénesis 

endotelial (Ponce, 2001, 2009) y encapsulación 3D para la ingeniería de tejidos (Mondrino et al., 

2006; Li y Guan, 2011), son otras de las múltiples aplicaciones en los que los hidrogeles de 

Matrigel han destacado. A pesar de su versatilidad de aplicaciones, Matrigel se encuentra 

rigurosamente limitada debido a la variabilidad en su composición entre lotes o proveedores, y 
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por la presencia de contaminantes exógenos. En consecuencia, han surgido indicaciones para 

tener la precaución en la confiabilidad e interpretación de los resultados en los cultivos celulares, 

sugerida por la variabilidad de la composición de hidrogel (Vukicevic et al., 1992; Benton et al., 

2011).  

De modo similar a lo que sucede en la composición, las propiedades mecánicas también 

presentan variabilidad entre lotes y también pueden variar en función de la temperatura y 

método de prueba. En experimentaciones, se ha logrado determinar la variación de la rigidez o 

módulo de elasticidad de los hidrogeles de Matrigel. Por ejemplo, con microscopía de fuerza 

atómica, los valores encontrados han sido de 400-840 Pa hasta 1-3 kPa (Soofi et al., 2009); con 

interferometría mecánica in situ el promedio de las mediciones a granel es ~650 Pa con 

variaciones hasta los 1-2 kPa (Reed et al., 2009). La heterogeneidad en la rigidez de Matrigel se le 

ha atribuido principalmente a los cambios graduales en la remodelación de la MEC y al espesor 

del hidrogel a lo largo del tiempo (Reed et al., 2009), así como también a la influencia del sustrato 

subyacente sobre el hidrogel (Kohen et al., 2009). 

2.3.1.3 Hidrogeles de MEC descelularizada 

Los tejidos y órganos descelularizados han tenido un enfoque importante en las aplicaciones 

clínicas para la reparación y regeneración de tejidos, así como también para estudios pre-clínicos 

en la medicina regenerativa y farmacología. Recientemente, se ha mostrado un gran interés en la 

producción de hidrogeles de MEC de tejidos descelularizados debido a su esperada 

biocompatibilidad y bioactividad por encima de los hidrogeles convencionales (Malafaya et al., 

2007); además, los componentes de las MECd proporcionan la cantidad de información suficiente 

y necesaria para el funcionamiento celular como el crecimiento, diferenciación, proliferación y 

migración (Frantz et al., 2010). En este sentido, los andamios a partir de MECd parecen ser 

prometedores para ser los sustratos biomiméticos ideales para recrear el microambiente celular.  

El proceso que ejerce la formación de los hidrogeles de MEC descelularizada (MECd) es el 

autoensamblaje de proteínas y péptidos regulado principalmente por la presencia de colágena, 

glucosaminoglicanos y proteoglicanos de la MEC (Brightman et al., 2000). Después de la 

descelularización, las MEC se pulverizan y luego se someten a procesos de solubilización o 
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digestiones enzimáticas; los protocolos más comunes de solubilización enzimática utilizan 

pepsina gástrica bovina (Drake et al., 1966; Miller, 1972) con la finalidad de romper enlaces de 

telopéptidos de la estructura de la triple hélice de la colágena bajo condiciones ácidas (ácido 

clorhídrico diluido) (Hulmes, 2008; Freytes et al., 2008), seguido de una reacción de 

neutralización. De esta manera, los monómeros proteicos disponibles y la neutralización 

controlada por temperatura y pH, permitirán el ensamblaje espontáneo de los enlaces 

intramoleculares para la formación del hidrogel. A su vez, la cinética de polimerización estará 

influenciada por la naturaleza bioquímica del tejido nativo y las proteínas que hayan quedado 

prevalecidas después del proceso de descelularización (Crapo et al., 2011; Keane et al., 2012).  

Las propiedades mecánicas y biológicas de los hidrogeles de MECd muchas veces son 

dependientes del tipo específico de MEC y su concentración en solución (Wolf et al., 2012); no 

obstante, muchas de estas propiedades se han visto modificadas después de la descelularización 

(Nakayama et al., 2010; Goh et al., 2013). En células madre, estos cambios en la rigidez de los 

hidrogeles de MECd pueden afectar la diferenciación celular, alterando la función a causa de los 

procesos de mecanotransducción (Engler et al., 2006, 2007; Reilly y Engler, 2010; Pennesi et al., 

2011; Tse y Engler, 2011); sin embargo, existen reticulantes químicos como el glutaraldehído 

(Singelyn y Christman, 2011), etildimetilaminopropil carbodiimida y N-hidroxisuccinimida (Liao y 

Simionescu, 2013) que modulan la rigidez de los hidrogeles en función a las necesidades del 

cultivo.  

En modelos hepáticos, múltiples investigaciones han dilucidado que la MEC tiene la capacidad de 

mantener le fenotipo de los hepatocitos. Las células fueron cultivadas entre dos capas de hidrogel 

de MECd de hígado porcino y preservaron su fenotipo al observarse los marcadores bioquímicos 

como la producción de albúmina, urea y capacidad de transporte (Sellaro et al., 2010). Por otro 

lado, en hepatocitos de cultivo primario embebidos en hidrogeles de MECd de hígado, mostraron 

alta actividad de síntesis de albúmina y actividad etoxi-resorufina-O detilasa (EROD) durante 3 

semanas de cultivo; además mostraron una alta supervivencia cuando los hidrogeles con los 

hepatocitos embebidos fueron implantados en ratas hepatectomizadas, logrando demostrar la 

formación de una estructura muy similar al tejido hepático 2 veces con respecto a hepatocitos 

embebidos en hidrogeles de colágena (Ijima et al., 2019).  
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2.3.1.4 Incorporación de proteínas de MEC en hidrogeles de PA 

Los hidrogeles, a pesar de mostrar una gran capacidad de imitar una MEC en cuanto a su 

microestructura y composición (Tibbitt y Anseth, 2009), no logran todavía obtener la complejidad 

biológica consistida por la gran diversidad de moléculas propias de la MEC nativa (Boudreau y 

Bissell, 1998). Regularmente, muchos hidrogeles son complementados con moléculas de MEC 

como el ácido hialurónico (Hassan et al., 2013), colágenas (Rafat et al., 2008; Callahan et al., 

2012), lamininas (Suri y Schmidt, 2010), elastinas (Annabi et al., 2013) o fibronectinas (Ingenito et 

al., 2010), con la finalidad de modificar el entorno celular y mejorar algunas de sus funciones 

biológicas. Por tal motivo, se han intentado incorporar péptidos conjugados a las cadenas 

poliméricas de los hidrogeles, como alternativa ante las desventajas que estos materiales 

proporcionan. Hasta ahora, uno de los mejores candidatos considerados para realizar las 

mencionadas modificaciones, son los hidrogeles sintéticos.  

Particularmente, la poliacrilamida es un polímero sintético producto de la reacción de 

monómeros de acrilamida y el reticulante bis-acrilamida, en presencia de persulfato de amonio 

(APS) y tetrametiletilendiamina (TEMED) (Figura 7); ambos funcionan como fuente de radicales 

libres y como catalizadores para iniciar la polimerización por los radicales redox, respectivamente. 

Por otro lado, la PA ofrece interesantes ventajas para su aplicación en los cultivos celulares; entre 

ellas, es la posibilidad de modificar su módulo de elasticidad o rigidez variando las 

concentraciones de acrilamida y bis-acrilamida (Pelharm y Wang, 1997; Tse y Engler, 2010), sin 

alterar la naturaleza química de la superficie del material, misma que es importante para la 

propagación celular debido a la densidad del ligando conjugado (Engler et al., 2004a); además, la 

PA es un polímero inerte donde interactúan moléculas adhesivas selectivas para unirse 

covalentemente a la red polimérica, funcionando así como ligandos para la adhesión celular 

(Georges y Janmey, 2005). Debido a esto, existen protocolos estandarizados para la fabricación 

de hidrogeles de PA con rigidez controlable y acoplamiento de proteínas (Tse y Engler, 2010); 

recientemente, estos protocolos también han sido diseñados para el cultivo celular en cajas de 

poliestireno multipozos para ensayos de mecanobiología (Díaz-Bello et al., 2019). La modulación 

de la mecánica y la bioquímica, puede dirigir a una compresión más profunda de las posibles 

respuestas celulares complejas que muchas veces no se logran visualizar con hidrogeles naturales.  
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En un estudio realizado con células madre mesenquimales humanas (hMSC), se observó que su 

propagación y proliferación aumentan en proporción al incremento de la rigidez de la PA, pero 

ocurría menos en los hidrogeles de PA recubiertos con laminina con respecto a los recubiertos 

con proteínas de MEC, lo que sugiere que la presencia de ligandos adhesivos a la superficie 

pueden modificar la respuesta celular (Rowlands et al., 2008). De la misma forma, otra de las 

investigaciones más sobresalientes, ha sido el cultivo de hepatocitos sobre sustratos de PA con 

distintos rangos de rigidez fisiológica recubiertos con proteínas de colágena, como modelos de 

fibrosis hepática. En este experimento, las células cultivadas en los sustratos más cercanos a las 

condiciones fisiológicas al hígado sano, mostraron una mayor regulación funcional del factor 

nuclear 4α de los hepatocitos (HNF4α), mientras que la matriz fibrótica inhibió la regulación 

transcripcional de este factor típico de fenotipo de hepatocitos (Desai et al., 2016). 

 

  

Acrilamida 
N,N’-Metileno-bis-acrilamida (BIS) 

Persulfato de amonio  TEMED Poliacrilamida 

Figura 7. Reacción de polimerización de la acrilamida. La N,N’-Metileno-bis-acrilamida (BIS) actúa como 
un reticulante entre las subunidades de la acrilamida. La catálisis está dada por la generación de radicales 
libres por el persulfato de amonio en presencia de TEMED. El producto final es una red polimérica, la cual 
su tamaño de poro puede ser controlada por la concentración de acrilamida y BIS reticulante. Imagen 
tomada y modificada de Kamdow et al., (2007). 
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3. JUSTIFICACIÓN 

El hígado representa uno de los órganos más importantes en seres humanos, desempeña 

funciones como el metabolismo de xenobióticos y la síntesis de biomoléculas indispensables para 

la vida, por lo que el daño en este órgano podría comprometer las funciones vitales en los 

individuos. De ahí la importancia de los cultivos celulares para la evaluación de fármacos en las 

pruebas pre-clínicas y verificar si estas tienen efectos hepatotóxicos. Sin embargo, los cultivos in 

vitro convencionales de hepatocitos, muchas veces no disponen de las condiciones adecuadas de 

adhesión celular al sustrato o soporte en que se encuentran, lo que implica que la célula pierda 

algunas de sus características fenotípicas a las pocas horas de cultivo. Como alternativa, se han 

intentado generar biomateriales derivados de proteínas derivadas de matriz como la colágena 

tipo I de tendón de cola de rata y Matrigel®, debido a su capacidad adherente en la interacción 

célula-sustrato; no obstante, la principal desventaja que presentan, es que todavía no logran 

recrear el microambiente de una matriz hepática, lo que podría desencadenar una pérdida de 

fenotipo de los hepatocitos. Por esta razón, es necesaria la búsqueda de nuevas estrategias 

biotecnológicas para la generación de materiales biomiméticos a partir de proteínas de MECd, 

que permitan imitar y recrear de mejor manera el microambiente mecánico y bioquímico de un 

tejido hepático nativo en conjunto con combinaciones de otras proteínas derivadas de MEC. 

Asimismo, encontrar la combinación ideal de componentes proteicos de MEC, sería un desafío 

para la promoción de la adhesión celular en hepatocitos sobre los andamios de cultivos celulares, 

pues se ha evidenciado que la adherencia celular al sustrato es un proceso clave para el 

mantenimiento de la sobrevivencia y conservación fenotípica de los hepatocitos.  

Con esta tecnología, en un futuro se podrían realizar cultivos celulares para la regeneración de 

tejidos hepáticos, así como ensayos pre-clínicos para la prueba de nuevos fármacos que induzcan 

una respuesta celular.  
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4. HIPÓTESIS 

Los péptidos diferenciales de MECd incorporados a hidrogeles de rigidez suave, proporcionarán 

mejores condiciones en la respuesta al esparcimiento y agregación celular en cultivo primario de 

hepatocitos. 

5. OBJETIVOS 

5.1 Objetivo general 

Evaluar el efecto de los péptidos diferenciales derivados de MECd de hígado sobre el 

esparcimiento y agregación de hepatocitos cultivados en hidrogeles de rigidez controlada. 

5.2 Objetivos específicos  

1. Extraer péptidos diferenciales derivados de MECd de hígados de rata. 

2. Incorporar péptidos diferenciales a hidrogeles de poliacrilamida de diferente rigidez.  

3. Evaluar los cambios ocurridos en el esparcimiento, agregación y supervivencia celular.  
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6. MATERIALES Y MÉTODOS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.1 Descelularización de hígados de rata 

Las MECd se obtuvieron de hígados de rata macho de la cepa Wistar de 250-300 g. Primeramente, 

las ratas se anestesiaron con 0.5 mL de pentobarbital sódico y se realizó la laparotomía realizando 

una incisión en línea recta en el centro del abdomen y dos cortes perpendiculares en dirección a 

los riñones. Los órganos de la cavidad abdominal fueron removidos para dejar expuesto 

solamente al hígado y las venas porta y cava.  

Figura 8. Esquema general de la metodología experimental. 
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Con el apoyo de unas pinzas de sujeción, se colocaron dos hilos por debajo de la vena porta: uno 

sencillo denominado hilo guía y el segundo (doble o triple) denominado hilo de amarre, tal como 

se observa en la Figura 6a. El hilo de guía ayuda a tensar la vena para observar su dirección y el 

hilo de amarre, colocado antes de la bifurcación que se dirige hacia los diferentes lóbulos, es el 

que posteriormente sujetará la vena porta con la cánula y soportará todo el peso del hígado. 

Una vez colocado los hilos, se administró 0.2 mL de heparina sódica 1000 UI/mL en la vena cava 

para evitar la coagulación en caso que el animal falleciera antes del término de la operación. A 

continuación, se realizó una pequeña incisión en la vena porta y con el apoyo del hilo guía se 

insertó cuidadosamente una cánula (previamente conectada a una bomba peristáltica) para 

iniciar un pre-lavado con agua desionizada a 4°C y desgasificada por sonicación, a un flujo de 5 

mL/min. La vena porta y la cánula quedaron sujetas entre sí realizando un nudo firme con el hilo 

de amarre y finalmente, se extrajeron los hígados completos retiraron los excesos de tejido 

adiposo, muscular y conectivo. En seguida, los hígados fueron colocados y sujetados 

cuidadosamente en vasos de precipitados hasta concluir con el pre-lavado por 30 min (Figura 9b-

c).  

Los hígados lavados se trasladaron a vasos de precipitados que contenían 600 mL de una solución 

de descelularización previamente desgasificada, compuesta por 1% Tritón X-100, 0.1% NH4OH 

[30%], 0.01 µg/mL de DNAsa pancreática bovina [10 µg/mL] y 0.1 mM de MgCl2 en agua 

desionizada. Los hígados fueron perfundidos con la solución de descelularización y se 

mantuvieron en recirculación durante toda la noche a un flujo constante de 5 mL/min, a 

temperatura ambiente (Figura 6d).  

Al finalizar el proceso de descelularización, los hígados se lavaron con agua desionizada durante 

4 h y las MEC resultantes se colocaron en cajas Petri de vidrio, se eliminó el exceso de agua y por 

último, se almacenaron a -70°C hasta su posterior uso.   
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6.2 Aislamiento de péptidos de MECd 

Las MECd se liofilizaron a -70°C y 200 mTorr durante 12 h o hasta observar la ausencia total de 

agua. Se obtuvo el peso seco de cada una y se maceraron en un mortero con nitrógeno líquido 

hasta la obtención de un polvo fino. Luego, en tubos cónicos se realizaron las digestiones 

enzimáticas con pepsina gástrica bovina con base a la relación de 10 mg de MECd/mg de 

pepsina/mL de HCl 0.1 N y se mantuvieron en un agitador orbital a temperatura ambiente. Los 

productos de la reacción enzimática se recuperaron en microtubos de 1.5 mL a 1, 2, 4, 6, 24 y 48 

h, y estos se neutralizaron con NaOH 10 M para inactivar la reacción en cada tiempo de digestión. 

Posteriormente, todas las muestras se centrifugaron a 13300 rpm (17000 xg), durante 10 min a 

4°C, se recuperaron los sobrenadantes (proteínas solubles) de cada producto de la digestión 

enzimática y finalmente, se conservaron a -70°C.  

6.3 Caracterización de proteínas de MECd 

Las proteínas digeridas enzimáticamente se cuantificaron por el método de Lowry con base al 

protocolo del Kit DC Protein Assay de BioRad®, empleando una curva estándar de albúmina de 

suero bovino (BSA) [1.5 mg/mL] con las concentraciones [0.25, 0.5, 1.0 y 1.5] mg/mL y como 

muestra blanco se empleó buffer de fosfatos salino (PBS). Las proteínas de MECd a cuantificar se 

diluyeron en PBS a una relación 1:10. 

Hilo de 

amarre 

Hilo      

guía 

Vena   

porta 

Vena   

cava 

a) 

Figura 9. Proceso de canulación durante la descelularización. a) La vena porta queda expuesta para 

colocar los hilos guía y de amarre. b) La punta de la cánula y su sujeción con la vena debe situarse antes 

de la bifurcación. c) El nudo durante la sujeción debe ser suficientemente fuerte para sostener al hígado 

durante todo el proceso de descelularización y d) el hígado debe estar sumergido ligeramente en la 

solución. 

b) c) d) 
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Los datos de absorbancia se obtuvieron por espectrofotometría a una longitud de onda de 750 

nm y se determinó la ecuación lineal en Microsoft® Office Excel para conocer las concentraciones 

de proteínas en la dilución. 

Con la finalidad de realizar un perfil comparativo de péptidos de las proteínas a utilizar para la 

fabricación de los sustratos de cultivo, se realizó SDS-PAGE 8% y sobre los geles de poliacrilamida 

(29:1) se colocaron 40 µg de proteínas de MECd y 20 µg de otras proteínas derivadas de MEC: 

colágena tipo I (Col I) de tendón de cola de rata, membrana basal (MB) de Matrigel® y 

combinaciones (en término de porcentaje) 50/50 y 75/25 de Col I y MB, respectivamente. Las 

proteínas se separaron durante 1.5 h a 120 V. Finalizando, los geles se tiñeron con azul de 

Coomassie R250 y nitrato de plata (ver Anexo I) para visualizar el perfil de péptidos obtenidos. 

Para identificar las proteínas presentes y su abundancia en cada una de las muestras, se realizó 

inmunoblot (protocolo detallado en Anexo II). Para ello, las proteínas separadas por SDS-PAGE 

fueron transferidas a membranas de PVDF (polivinildifluoruro), se incubaron con una solución de 

bloqueo compuesta por 5% suero de leche baja en grasa en TBST 1X (Tris-HCl, 150 mM NaCl y 

0.1% Tween-20, pH 7.6) por 1 h en agitación y se lavaron tres veces con agua desionizada y uno 

con TBST 1X. Luego, las membranas se incubaron con anticuerpos policlonales primarios de ratón 

para colágena tipo I a una dilución 1:2000 en 5 mL de TBST 1X durante toda la noche en agitación 

a 4°C y los anticuerpos secundarios anti-ratón conjugados con peroxidasa de rábano (HRP) a una 

dilución 1:5000 en TBST 1X durante 1 h en agitación, a temperatura ambiente. Posteriormente, 

las membranas se lavaron tres veces con TBST 1X, cada uno durante 5 min; se incubaron con 

luminol y sustrato para peroxidasa para la reacción quimioluminiscente y, finalmente, fueron 

reveladas en placas de rayos X.  

6.4 Cultivo primarios de hepatocitos 

Para el cultivo primario de hepatocitos de rata, primeramente se elaboraron sustratos de hidrogel 

de PA de rigidez controlada de 1 y 20 kPa, sobre cubreobjetos de 20 mm de vidrio funcionalizados, 

con base a los protocolos descritos por Tse y Engler, 2010 y Cretu et al., 2010 (ver Anexo III). Los 

valores de rigidez fueron seleccionados en función de obtener condiciones cercanas y alejadas al 

rango fisiológico de la matriz hepática nativa. Posteriormente, se entrecruzaron 0.1 mg/mL de 
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todas las proteínas derivadas de MEC y MECd empleando el método de fotoadhesión con NH-

éster acrilato, Irgacure® 2959, inducidos con luz UV a 365 nm. 

Los sustratos de hidrogel de PA entrecruzados con las proteínas fueron colocados en cajas 

estériles de poliestireno de 12 pozos y se prosiguió con la siembra de los hepatocitos de rata de 

cultivo primario, en una densidad celular de 2.5 x 105 en medio Feeding (medio Dulbecco´s 

modified Eagle´s, BSA, tampón de HEPES 1M, piruvato de sodio 100 mM, NaH2CO3, galactosa, 

prolina, insulina, transferrina, selenio y glutamina 200 mM) complementada con antibióticos, 

incubadas a 37°C en una atmósfera de 5% CO2.  

Para evaluar la capacidad proliferativa de los hepatocitos, se añadieron 20 ng/mL de el factor de 

crecimiento epidermal (EGF) a las 72 h de cultivo, en cada uno de los tratamientos.  

6.5 Ensayo de inmunofluorescencia y TUNEL 

Para el ensayo de detección de apoptosis por TUNEL, los hepatocitos cultivados en los hidrogeles 

de PA bajo las condiciones descritas anteriormente, se fijaron con 4% PFA y nuevamente se fijaron 

en una solución pre-enfriada de etanol y ácido acético relación 2:1, durante 5 min a 20°C. 

Posteriormente, las muestras se procesaron con base a las especificaciones del fabricante del 

Manual del Kit de Detección in situ con fluoresceína ApopTag de Merck Millipore®. 

En los ensayos de inmunofluorescencia, las células fueron lavadas con tampón de fosfatos salino 

Dulbecco (DPBS) 1X precalentado y enseguida, se fijaron con 4% paraformaldehído (PFA) en DPBS 

1X, durante 20 min a temperatura ambiente. Posteriormente, se permeabilizaron con 0.1 % de 

Tritón X-100 en DPBS 1X durante 10 min en agitación a temperatura ambiente. Luego, las células 

fueron bloqueadas con 10% de suero de caballo en PBS 1X durante 1 h en agitación, a 

temperatura ambiente. Los núcleos se tiñeron con DAPI (4',6-diamidino-2-fenilindol) en una 

dilución 1:200 en DPBS 1X y finalmente, las muestras se montaron con Mowiol® para su 

preservación. Las imágenes fueron obtenidas mediante microscopía de epifluorescencia. 
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6.6 Procesamiento de imágenes para cuantificar área celular, área nuclear, 

esparcimiento y agregados celulares, y análisis estadístico. 

El análisis y procesamiento de imágenes se realizaron con el software Fiji de ImageJ, considerando 

un mínimo de 10 imágenes por condición, de al menos 2 experimentos independientes. Los datos 

obtenidos se analizaron estadísticamente en el software GraphPad Prism 8, utilizando ANOVA de 

una sola vía y la prueba de comparación de medias por Tukey, atribuyendo como valores 

significativos si p <0.05. 
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7. RESULTADOS Y DISCUSIÓN 

7.1 El proceso de descelularización de hígados de rata generó MEC libres de componentes 

celulares 

Del proceso de descelularización se obtuvieron hígados libres de componentes celulares en un 

promedio de 19 h, al término de los lavados con agua desionizada. Las MEC resultantes mostraron 

una apariencia traslúcida, preservando su arquitectura y vasculatura innata o árbol vascular, tal y 

como lo describe Baptista et al., 2011, ver Figura 10. En este paso, los agentes descelularizantes 

Tritón X-100, NH4OH y los lavados con agua desionizada, permitieron remover todos los 

componentes celulares del hígado; la DNAsa I añadida mejoró el proceso al impedir obstrucciones 

del flujo en la vasculatura debido al material genético que se pudiese acumular. Otros protocolos 

de descelularización, como el presentado por Lee et al., 2013, no utilizan nucleasas, a cambio 

emplean detergentes aniónicos como el SDS por la alta eficiencia que muestra para eliminar todo 

el material celular de los órganos o tejidos; sin embargo, la desventaja que presenta, es que 

dependiendo del tiempo de exposición con los tejidos, es la probabilidad de generar daños hacia 

componentes importantes de la MEC como las proteínas, pudiendo generar posibles soportes 

disfuncionales para los cultivos celulares (Samouillan et al., 1999).  

 

 

 

 

 

  

Figura 10. Proceso de descelularización de hígados de rata, a través del tiempo. Las 0 h indican el 

inicio de la canulación para el primer pre-lavado con agua desionizada (0.5 h). A partir de 1 h a las 15 h, 

se llevó a cabo la descelularización de los hígados con la solución de Tritón X-100, NH4OH y DNAsa I. A 

las 19 h se obtuvieron las MEC al término de un lavado final con agua desionizada.   

Hígado nativo Agua desionizada Agua desionizada 1% Tritón X-100, 0.1% NH4OH, DNAsa I 

0.5 h 1 h 15 h 19 h 0 h 
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En modelos de válvulas cardíacas de cerdo, se compararon diferentes procedimientos de 

descelularización para observar el potencial de eliminación de componentes celulares y 

preservación de la matriz. El tratamiento con Tritón X-100 y desoxicolato de sodio lograron una 

descelularización completa y una preservación de la MEC, mientras que el SDS solamente eliminó 

completamente las células, pero ocasionó evidentes alteraciones estructurales en la MEC (Kasimir 

et al., 2003). Esto es debido a que el SDS conduce a la desnaturalización de las fibras de colágena 

al desestabilizar sus hélices (Samouillan et al., 1999). 

7.2 Los perfiles de proteína de las MECd presentan diferencias en función del tiempo de digestión 

con pepsina  

En un sistema de andamiaje de MECd para cultivo celular, la conservación de las ‘huellas 

dactilares’ específicas del tejido es indispensable para la adhesión y diferenciación celular (Crapo 

et al., 2011), lo que despertó el interés de dirigir este trabajo a la búsqueda de la composición 

ideal de proteínas que permitiera mejorar la sobrevivencia y capacidad de adhesión de los 

hepatocitos cultivados en los hidrogeles de PA, ya que de esta manera, permitiría simular la 

heterogeneidad de la composición proteica del lobulillo hepático. Dicha propuesta, conllevó al 

análisis del perfil comparativo de las proteínas derivadas de MEC (Col I y MB) y MECd digeridas a 

distintos tiempos con pepsina, a través de SDS-PAGE, para evidenciar las variaciones en la 

composición de cada uno los sustratos. 

El perfil de separación de proteínas de MECd por SDS-PAGE, mostró que, en tiempos largos de 

digestión con pepsina (> 24 h), la proporción de proteínas solubles de menor tamaño aumentaba 

a consecuencia de una mayor fragmentación de otras proteínas, como se visualiza en la Figura 

11a. En los SDS-PAGE, los perfiles de digestión con pepsina de las proteínas mostraron diferencias 

entre los tiempos cortos (<24 h) y largos de digestión, similar a lo demostrado en investigaciones 

recientes en MECd de pulmones de cerdo (Pouliot et al., 2020) y en tejidos cardíacos 

descelularizados (Willians et al., 2015), logrando confirmar el efecto que ejerce el tiempo de 

digestión con pepsina sobre la variabilidad de fracciones de proteínas solubles de MEC obtenidas; 

además, estas diferencias de fracciones de proteínas por producto de digestión, han evidenciado 

estar relacionadas en la determinación de las propiedades físicas y bioquímicas de los hidrogeles 

realizados a partir de MECd, así como en la viabilidad celular (Lin y Liu, 2006; Pouliot et al., 2020). 
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Asimismo, se ha comprobado que las diferencias en el tiempo de digestión, influyen en la 

composición de la MECd; en tiempos cortos (a partir de 1 h), las MECd son enriquecidas con 

fragmentos de proteínas menos reticuladas (como Col IV de membrana basal), mientras que en 

tiempos largos (a partir de 4 h) las MECd contienen mayores cantidades de colágenas fibrilares 

(como Col I y Col III) (Serna-Márquez et al., 2020). En este contexto, para demostrar si la 

variabilidad de fracciones de proteínas de MECd de hígados lograba generar un efecto en el 

cultivo de hepatocitos, se optó por seleccionar únicamente las proteínas de 2 y 48 h de digestión 

para los ensayos posteriores de cultivo celular. De esta manera, se esperaría observar qué MEC 

es la ideal para el cultivo primario de hepatocitos.  

Como se esperaba, la acumulación de las fracciones correspondientes a Col I (cadenas 1 y 2 

entre 100 y 150 kDa) disminuyó en las mezclas Col/MB, pero visualmente más significativo en MB. 

En MECd 2 h, en donde aparentemente se conserva un perfil muy similar a MB, es decir la carencia 

de las cadenas 1 y 2 del Col I; MECd 48 h, se observa que presenta mayor presencia de Col I, sin 

embargo, considerar realizar la técnica de Western blot podría ayudar a complementar la 

información respecto a la presencia, incluso, de otras proteínas.  

Para validar estos resultados, se realizó la detección de Col I en las proteínas derivadas de MEC 

empleando la técnica de inmunoblot. Esta caracterización permitió confirmar la proporción 

acumulada de la proteína fibrilar vía los perfiles de separación mostrados por SDS-PAGE. En la 

Figura 11c, claramente se refleja la disminución gradual de Col I a partir de las muestras de 

proporciones de Col/MB; asimismo, en MB se reafirma que existe una ausencia de la proteína 

fibrilar, como se mostró en la Figura 11b. En análisis proteómicos realizados en Col I purificado, 

Matrigel y MECd de hígados de rata por Li et al., (2016), se lograron identificar las proteínas más 

abundantes y esenciales para la unión celular, crecimiento y diferenciación de los hepatocitos. De 

manera interesante, se reveló que Col IV con las cadenas 1 y 2 (membrana basal ubicua) estuvo 

presente en las 3 muestras; sin embargo Col IV con las cadenas 3, 5 y 6 (membrana basal 

restringida espacial y temporalmente) (Keene et al., 1988) fueron encontrados exclusivamente 

en MECd de hígados, además de transglutaminasa-2, biglicano, fibrinógeno y fibronectina, entre 

otras proteínas que se encuentran ausentes en Col I y en Matrigel, mostrando así la singularidad 

del hígado de rata descelularizado en comparación con estos dos últimos (Li et al., 2016). 
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7.3 La mecánica y la composición de proteínas de MEC conjugadas a los sustratos de hidrogel de 

PA influyen en el comportamiento de los hepatocitos 

 

Los hepatocitos son las células más abundantes del hígado y realizan la mayoría de las funciones 

fisiológicas en el órgano. Si bien estas funciones se ven reguladas por la composición de las 

proteínas presentes en la matriz a lo largo de los lobulillos hepáticos (Zeisberg et al., 2006), varias 

investigaciones han demostrado que la función y comportamiento de los hepatocitos también se 

ven influenciados por los cambios en la rigidez de su microambiente in vivo, es decir, son células 

altamente mecanosensibles; incluso está relacionado con el desarrollo de enfermedades 

hepáticas crónicas (Gomez-Dominguez et al., 2008; Sporea et al., 2010; Cox et al., 2011; 

Cassinotto et al., 2016; Qi et al., 2017). En los sistemas biológicos, la rigidez es referida como una 

propiedad biomecánica del tejido que actúa como un mediador importante del comportamiento 

celular como el crecimiento, supervivencia y motilidad (Wells, 2008, 2013; Handorf et al., 2015). 

Figura 11. Caracterización de proteínas para sustratos de hidrogel. a) Perfil de separación de las 

proteínas de MEC hidrolizadas con pepsina a distintos tiempos. b) Comparación de perfiles proteicos 

de las proteínas de colágena I (COL I), proporciones distintas de Col I y MB, MB, laminina (LN) y 

fibronectina (FN). MP: marcador de peso molecular.  
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Por esta razón, además de evaluar el efecto que ejercen las variaciones de proteínas conjugadas 

en los sustratos de hidrogel sobre los hepatocitos, se decidió evaluar el efecto de la rigidez en 

condiciones suaves (1 kPa) y rígidas (20 kPa) a las 24 y 72 h de cultivo (Figura 9a).  

En todos los sustratos de cultivo en las condiciones suaves y rígidas, los hepatocitos mostraron 

diferencias estadísticamente significativas en el área de células individuales a partir de las 24 h; 

no obstante, esta diferencia no fue evidente entre los hepatocitos cultivados solamente en 1 kPa 

a las 24 y 72 h, pero sí un cambio significativo en 20 kPa (Figura 12c). En estas condiciones rígidas 

a las 24 h, las células se adhirieron, se extendieron y exhibieron un aumento del área de 

esparcimiento y de formación de agregados en todos los hidrogeles; a las 72 h, los hepatocitos 

condujeron su morfología a una forma extendida, aplanada y de huso, tipo fibroblastoide (ver 

Figura 12a), atribuida principalmente a la formación de fibras de estrés (o de tensión) en 

respuesta a la polimerización de la actina a consecuencia de esfuerzos mecánicos (Nekouzadeh 

et al., 2008) y al crecimiento y elongación de las adhesiones focales, tal como se demostró en 

células mesenquimales humanas cultivadas en hidrogeles de PA en distintos intervalos de rigidez 

(Engler et al., 2006). Otros estudios, han logrado determinar que la unión y aumento del área de 

los hepatocitos se maximiza a partir de 4.6 kPa cuando son cultivados en MECd incorporada a 

hidrogeles de ácido hialurónico (Deegan, 2015). Además, en cultivo primario de hepatocitos de 

ratón, se destacó que la tensión del citoesqueleto se incrementa logarítmicamente en proporción 

al aumento de la rigidez de los sustratos de geles de PA con Col I entrecruzada; las células se 

muestran aplanadas y con los núcleos más visibles. En sustratos de rigidez cercana al de un hígado 

normal (~140 Pa), los hepatocitos se muestran redondeados con sus núcleos más definidos  (Desai 

et al., 2016). 
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Por su naturaleza, las células suelen presentar cambios dependientes de las características de la 

superficie en que se encuentran, influyendo en su forma, polaridad, migración, proliferación y 

diferenciación (Clark et al., 1991; Disckinson et al., 1994; Brunetti et al., 2010). Las células 

interactúan físicamente con la MEC a través de las adhesiones focales para su dependencia de 

anclaje (Wang et al., 2002); estas interacciones ejercen fuerzas de estrés suficientes para generar 

cambios en los tejidos, por medio de la conversión de estímulos mecánicos en señales 

bioquímicas que propician la activación de distintas vías de señalización como las vías intrínsecas 

de agrupación de integrinas, la vía de la proteína quinasa asociada a Rho y otras quinasas 

reguladas por señales extracelulares (ERK) (Paszek et al., 2005; Provenzano et al., 2009; Lessey et 

al., 2012). Asimismo, la variación de la rigidez en los sustratos afecta las adhesiones focales y la 

formación del citoesqueleto de células diferenciadas. Las isoformas de miosina II no musculares 

son las principales proteínas responsables de tensar las estructuras corticales del citoesqueleto 

Figura 12. Hepatocitos de cultivo primario en hidrogeles de distinta rigidez y MEC conjugada. a) 

Micrografías de campo claro de hepatocitos cultivados en hidrogeles de PA de 1 y 20 kPa con diferentes  

proteínas derivadas de MEC y MECd conjugadas, después de las 24 y 72 h. Objetivo 20X; barra de escala: 

100 µm. b) Magnificaciones representativas de hepatocitos individuales, en apoptosis, en agregados y 

transformadas en estado indiferenciado. Barra de escala: indicada en cada imagen. c) Área de 

hepatocitos individuaes cultivados en hidrogeles de PA de 1 y 20 kPa con distintas proteínas derivadas 

de MEC y MECd, después de 24 y 72 h. Los datos son representados como la media ± desviación estándar 

(SD) de 2 experimentos independientes, ****p < 0.0001, *** p < 0.001, **p=0.0021, sn: no significativo. 

Proteínas de MEC: Col I: colágena tipo I; MB: membrana basal; 75/25: porporciones de 75% colágena 

tipo I y 25% membrana basal; 50/50: proporciones de 50% colágena tipo I y 50% membrana basal; MECd 

2h: matriz extracelular descelurizada digerida enzimáticamente a las 2 h; MECd 48 h: matriz extracelular 

descelurizada digerida enzimáticamente a las 48 h. 
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de actina, implicadas a su vez, en trasmitir la fuerza desde el interior de la célula a la matriz 

(Beningo et al., 2001; Wang et al., 2002; Tamada et al., 2004; McBeath et al., 2004; Kim et al., 

2005). En este mismo contexto, los cambios presentados en los hepatocitos por efecto de la 

rigidez en este estudio, contribuyen al complemento de las investigaciones realizadas 

previamente con células hepáticas (hepatocitos, endoteliales, estrelladas y carcinoma) sobre 

sustratos de PDMS (Natarajan et al., 2015) e hidrogeles de PA y colágena (Ford et al., 2006; Olsen 

et al., 2011; Patel et al., 2012; Desai et al., 2016; Liu et al., 2017).  

Múltiples investigaciones han resaltado la importancia de la estructura y composición bioquímica 

de MEC para influir en el dinamismo celular (Rojkind et al., 1980; Geiger et al., 2001; Tomas et al., 

2010; Porth et al., 2010; Lee et al., 2013). Además de los cambios convincentes de los hepatocitos 

por efecto de la rigidez, las células mostraron diferencias en su comportamiento en función al 

sustrato de proteínas de MEC y MECd. A las 24 h de cultivo en condiciones suaves (1 kPa), las 

células manifestaron una adherencia preferencial al sustrato en los hidrogeles de PA que 

contenían cualquiera de las concentraciones de Col I conjugado (Figura 12a); asimismo, se 

observó que el número y tamaño de aglomerados, al igual que el esparcimiento celular, 

incrementaban proporcionalmente al aumento de la concentración de Col I en el hidrogel. 

Mientras tanto, en los hidrogeles de MB (100%) de Matrigel, las células mostraron una morfología 

redonda y con la presencia de cuerpos apoptóticos, incluso, hasta las 72 h, evidenciando menor 

población celular en comparación con los hidrogeles con Col I. Por otro lado, el comportamiento 

de los hepatocitos cultivados a las 24 h sobre los hidrogeles de MECd 2 y 48 h en condiciones 

suaves, aparentemente fue muy similar a los cultivados sobre MB en cuanto a la morfología y la 

aparición de algunos cuerpos apoptóticos. Después de las 72 h, en MECd 48h, los hepatocitos 

formaron un mayor número de agregados celulares; por el contrario, en MECd 2 h, la población 

celular disminuyó en relación con el aumento de los cuerpos apoptóticos. En este contexto, desde 

finales del siglo pasado, se ha dilucidado la relación de la apoptosis con las moléculas señal de 

adhesión celular (célula-célula y célula-MEC) y su importancia para la señalización y unión celular 

como factores de supervivencia (Re et al., 1994; Schwartz, 1997); asimismo, la pérdida de estas 

interacciones celulares puede desencadenar la activación de vías de señalización que conducen a 

la apoptosis (Su et al., 2005; Li et al., 2019). Durante este proceso, comúnmente se observa la 

formación de pequeñas vesículas debido a la encapsulación de residuos celulares provenientes 
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de proteínas degradadas, fragmentos de material genético por daño nuclear, orgánulos, 

citoplasma y de membrana plasmática, en la etapa temprana de la apoptosis celular, 

observándose claramente en microscopía óptica como pequeños ‘cuerpos luminosos’, tal como 

se observa en MB de la Figura 12a; además, las células que se encuentran en apoptosis 

experimentan disminución de su tamaño, formación de ampollas en la membrana y un 

empaquetamiento intracelular más denso (Moss et al., 2006; Xu et al., 2019).  

Como se mencionó anteriormente, la mecánica ejerce efecto importante sobre la respuesta 

celular. Por esta razón, los hepatocitos cultivados en las condiciones rígidas (20 kPa), la adhesión 

al sustrato fue favorecida a las 24 h en todos los hidrogeles de MEC y MECd, incluyendo MB y 

MEC 2h. En 72 h, los hepatocitos inmersos a estos entornos no fisiológicos, modificaron 

evidentemente su morfología hacia formas aplanadas, ramificadas y de huso, similares a células 

mesenquimales indiferenciadas, particularmente al fenotipo de un fibroblasto. En condiciones 

fisiológicas de rigidez (1.5-4.5 kPa) (Takeda et al., 2006), las variaciones en la composición de la 

MEC tienen gran influencia en el fenotipo de los hepatocitos, tal como en su morfología; sin 

embargo, los microambientes rígidos o fibróticos (>4.1 kPa) (Takeda et al., 2006), estimulan una 

acelerada desdiferenciación y promueven la proliferación celular (Semler et al., 2005; Sharp et 

al., 2005) a causa de la alteración de las actividades de las vías de mecanotransducción, 

principalmente de reguladores trascripcionales como HNF-4α, involucrado en la diferenciación de 

los hepatocitos (Desai et al., 2016).  

Hasta ahora, los resultados han revelado que la relación de MEC y rigidez de los sustratos afectan 

la adherencia, morfología, formación de aglomerados y el área de esparcimiento de los 

hepatocitos de cultivo primario, determinados a su vez por la organización del citoesqueleto de 

actina. Y que además, aparentemente, la presencia de Col I conjugado en los hidrogeles mejora 

la adherencia de los hepatocitos a diferencia de los colágenos de membrana basal, como Col IV, 

y las fracciones de proteínas presentes en MECd digeridas 2 h. 

Las tensiones inducidas por el citoesqueleto en la MEC ocurren fuera de la célula, donde la 

membrana citoplasmática es la interfaz dinámica a través de las adhesiones focales; no obstante, 

este fenómeno ocurre de manera similar sobre el interior del núcleo a través de factores análogos 

a las adhesiones focales pero sobre la membrana nuclear, cuya función es ser el intermediario 
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sensible a la fuerza entre el citoplasma y la cromatina (Chancellor et al., 2010; Lovett et al., 2013; 

Swift et al., 2013; Alam et al., 2015). Dicho de este modo, las imágenes de los hepatocitos 

marcados con DAPI obtenidas por epifluorescencia, revelaron la variación del área nuclear por 

efecto de la rigidez de los hidrogeles de PA, independientemente de la composición de proteínas 

conjugadas. Los hepatocitos cultivados en los hidrogeles de 20 kPa, después de las 72 h, 

mostraron un aumento significativo en las áreas nucleares con respecto a los cultivados en 1 kPa 

(Figura 13). En los sustratos rígidos surgen tensiones mecánicas mayores en el microambiente 

extra e intracelular, y las células ensamblan fibras de tensión y adhesiones focales (George y 

Janmey, 2005; Yeung et al., 2005; Lele et al., 2006; Schelunck et al., 2008; Weng y Fun, 2011); en 

cambio, en los sustratos suaves, las fibras de tensión no pueden ser ensambladas y por 

consecuencia se generan fibras de tensión muy bajas. La tensión intracelular, al estar mediada 

parcialmente por el núcleo, puede desencadenar cambios en la morfología de los núcleos (Sims 

et al., 1992; Chancellor et al., 2010; Lombardi et al., 2011).  Asimismo, estos cambios de fuerza y 

resistencia externas de los núcleos pueden afectar procesos de conformación y ensamblaje de 

proteínas, y la localización de factores de transcripción, organización de cromosomas y alteración 

de la membrana nuclear, afectando posiblemente la expresión génica (Cho et al., 2017). 

Se ha mencionado anteriormente que la composición de las proteínas de MEC tiene relación con 

el área de los hepatocitos. En este sentido, también se observó un comportamiento similar con 

el área de los núcleos de las células cultivadas en 1 kPa a las 72 h, al observarse diferencias 

significativas entre el aumento del área nuclear en proporción al incremento de la concentración 

de Col I (Figura 13b). Asimismo, sobre los hidrogeles de MB y MECd 2 h, el área de los núcleos fue 

menor con respecto a Col I 100%; inclusive, el área de los núcleos de MECd 2 h fue mucho menor 

a los de MECd 48 h 
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Figura 13. El área nuclear de los hepatocitos depende de la rigidez y MEC conjugada. a) Micrografías 

de fluorescencia de núcleos marcados con DAPI en hepatocitos cultivados en hidrogeles de PA de 1 y 

20 kPa, y distintas proteínas de MEC y MECd conjugadas, después de 72 h. Objetivo 40x; barra de 

escala: 20 µm. b) Área nuclear de hepatocitos individuaes cultivados en hidrogeles de PA de 1 y 20 kPa 

con distintas proteínas derivadas de MEC y MECd, después de 72 h. Los datos son representados como 

la media ± desviación estándar (SD) de 2 experimentos independientes, ****p < 0.0001, *** p < 0.001, 

sn: no significativo. 
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En 20 kPa, evidentemente el área nuclear fue significativamente mayor (~1.8 veces) con respecto 

a 1 kPa, en todos los sustratos de proteínas de MEC y MECd conjugadas. Investigaciones han 

revelado que en la envoltura nuclear, el principal componente estructural es la lámina, 

conformado a su vez por proteínas de láminas fibrilares abundantes en hélices ensambladas sobre 

la membrana nuclear interna (Goldman et al., 2002; Gruenbaum et al., 2005). Estas proteínas se 

encargan de unir el núcleo con el citoesqueleto por medio de complejos de nucleoesqueleto y 

citoesqueleto, denominados como proteínas LINC (Crisp et al., 2006). De este modo, la lámina 

inmersa en la envoltura nuclear funciona como intermediario de multiplexado para 

mecanotransducir las señales ante los estímulos mecánicos (Cho et al., 2017). La mayoría de las 

tensiones en la MEC nativa mantienen estables a los colágenos fibrilares como Col I (Flynn et al., 

2010) y esto permite el mantenimiento de la integridad mecánica del tejido. Aunado a esto, 

análisis por espectrometría de masas realizados por Swift et al., (2013), descifraron la relación 

existente entre los niveles de Col I con la cantidad de proteínas de lámina, influyendo 

consecuentemente, en la elasticidad de los tejidos en una manera proporcional. Las células que 

se cultivaron en geles recubiertos de Col I de baja rigidez presentaron una forma esférica con 

núcleos rugosos y relajados; por el contrario, en los sustratos rígidos se generó propagación 

celular y los núcleos presentaron formas aplanadas y extendidas (Swift et al., 2013). Esta 

información brindada podría respaldar los resultados de las áreas nucleares de los hepatocitos de 

cultivo primario sembrados en los hidrogeles de PA con diferentes proteínas de MEC y MECd 

conjugadas.  

Las micrografías de campo claro (Figura 12) y la tinción de núcleos con DAPI (Figura 13) revelaron 

mayoritariamente la presencia de cuerpos apoptóticos en los hepatocitos cultivados en MB y 

MECd 2 h. No obstante, para tener una evidencia más clara del número de células apoptóticas en 

cada uno de los tratamientos, se realizó el ensayo de TUNEL, el cual identifica fragmentos de ADN 

bicatenario dañado, mediante TdT (desoxinucleotidil transferasa terminal). Esta enzima cataliza 

la adición de dUTP en los extremos 3´-OH del ADN y éstos son detectables mediante técnicas 

inmunohistoquímicas a través de microscopía de fluorescencia o citometría de flujo (Rode et al., 

2004; Elmore, 2007). De esta forma, los hepatocitos de cultivo primario marcados positivamente 

por TUNEL representados en la Figura 14a, fueron estadísticamente mayores en MB y MECd 2 h 

con respecto a Col I en sustratos de 1 kPa, a las 72 h (Figura 14c), visiblemente muy similar a lo 
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presentado anteriormente en campo claro (Figura 12). Por lo tanto, con la finalidad de observar 

la posibilidad de un rescate en la viabilidad de los hepatocitos en los sustratos de 1 kPa, las células 

fueron estimuladas con el factor de crecimiento epidermal (EGF). De modo interesante, 

solamente en MECd 2 h se logró observar un efecto significativo en la disminución de marcajes 

positivos por TUNEL y no en MB ni Col I (Figura 14c). No obstante, es considerable realizar más 

trabajo de investigación para entender los posibles mecanismos que expliquen por qué en 

determinadas condiciones puede ocurrir o no un rescate en la viabilidad ante el estímulo por EGF. 

Las funciones más importantes de EGF son la estimulación de síntesis de ADN, replicación celular 

y síntesis de proteínas (Cohen et al., 1995), favoreciendo al mismo tiempo el crecimiento celular, 

diferenciación, sobrevivencia y proliferación (Herbst, 2004); sin embargo, este último efecto no 

fue presentado en los hepatocitos cultivados en los hidrogeles que contuvieran Col I y MECd 48 h 

a 1 kPa después de las 72 h (Figura 14b), a pesar que se esperaba que las células aumentaran su 

estado de proliferación cuando se estimularan con EGF. El número de células proliferantes entre 

cada uno de los tratamientos con y sin EGF no presentó diferencias estadísticamente significativas 

(Figura 14d); no obstante, si bien no existió un aumento de células proliferantes, la observación 

de agregados celulares con estructura similar a cordones hepáticos, fueron más evidentes en las 

células cultivadas sobre los hidrogeles con Col I (Figura 14d). En contraste, los hepatocitos en 

MECd 48 h no mostraron este efecto de formación de agregados ante el estímulo con EGF. 

Probablemente, el efecto de EGF sobre los hepatocitos en cada uno de los tratamientos, aumentó 

solamente la actividad de moléculas de señal para la adhesión célula-célula y no célula-MEC. 

Estudios realizados por Fassett et al., revelaron la influencia de los geles de colágeno fibrilar (Col 

I) sobre la señalización de EGF y la progresión de ciclo celular en hepatocitos. A partir de las 

experimentaciones, se demostró que existe una relación entre la adhesión de las células en geles 

de colágena tipo I [0.5 mg/mL] con el aumento de la actividad de PKA (proteína Kinasa 

dependiente de cAMP) y la disminución de la fosforilación de los receptores de EGF, sugiriendo 

que la adhesión celular al colágeno fibrilar suprime la señalización de EGF. PKA es una molécula 

antagonista de la mitogénesis y de algunas rutas de señalización de EGF (Cook y McCormick, 1993; 

Wu et al., 1993) y su actividad depende de la arquitectura de la MEC que pudiera llegar a favorecer 
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o inhibir el crecimiento celular y los posteriores efectos sobre la señalización del factor de 

crecimiento y morfología celular (Fassett et al., 2006).  
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Figura 14. El factor de crecimiento epidermal (EGF) favorece la formación de agregados, pero no 

rescata la viabilidad de los hepatocitos. a) Micrografías de epifluorescencia de hepatocitos marcados 

con DAPI y TUNEL para la representación de células en apoptosis. Las imágenes fueron obtenidas de 

los hepatocitos cultivados en los hidrogeles de 1 kPa con proteínas de Col I, MB y MECd 2 h conjugadas, 

tratadas con o sin EGF, después de 72 h de cultivo. Objetivo 40x; barra de escala: 30 µm. b) Micrografías 

representativas de epifluorescencia (DAPI) y campo claro de hepatocitos tratados con y sin EGF, 

después de 72 h cultivados en hidrogeles de 1 kPa con diferentes proteínas de MEC conjugadas. 

Objetivos: 40x (epifluorescencia); 20x (campo claro). Barra de escala: 20 µm (epifluorescencia); 100 µm 

(campo claro). c) Cuantificación de células positivas en TUNEL en hidrogeles de PA de 1 kPa con Col I, 

MB o 2 h, tratadas con 0 y 20 ng/mL de EGF, correspondiente a las representaciones en a). d) 

Cuantificación de número de hepatocitos cultivados en hidrogeles de PA de 1 kPa con proteínas de Col 

I, 75/25, 50/50 o 48 h conjugadas, tratados con 0 y 20 ng/mL de EGF. e) Cuantificación de tamaño de 

agregados celulares de las representaciones de campo claro en b). f) Conteo de hepatocitos por 

agregado en las condiciones mencionadas en b). Todos los datos estadísticos están representados 

como la media±SD de 2 experimentos independientes; ns= no significante, **p=0.0021, **** p<0.0001. 
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Los mecanismos explicados anteriormente por Fassett et al., posiblemente podrían estar 

relacionados con los hepatocitos cultivados en los hidrogeles de 1 kPa y diferentes proteínas de 

MEC conjugadas con Col I presente, al no lograr proliferar ante el estímulo con EGF.  

Por otro lado, en cultivo primario de queratinocitos humanos, se logró dilucidar que la activación 

de la señalización de EGF puede regular los efectos de la rigidez de la MEC sobre la proliferación 

celular, y éste dependerá del ensamblaje de las adhesiones focales y la tensión del citoesqueleto; 

es decir, el aumento de la rigidez de la MEC promueve la activación de la vía de EGF, al menos, en 

este tipo celular. Además, se observó que en concentraciones elevadas de EGF [10 ng/mL], se 

generaba un incremento en el tamaño de las colonias de queratinocitos (Kenny et al., 2018). En 

este trabajo, la concentración empleada de EGF para el rescate de los hepatocitos en cultivo 

primario, fue de 20 ng/mL, razón por la cual, probablemente pudo haber influenciado en la 

formación de un mayor número de aglomerados celulares, reflejando posiblemente el efecto 

similar a lo observado en las colonias de queratinocitos. Asimismo, como se mostró en los 

resultados de proliferación de los hepatocitos, quizá la presencia de Col I en los hidrogeles en 

condiciones suaves, puede influenciar en la baja proliferación celular. No obstante, aún quedan 

por realizar más investigaciones que permitan demostrar si en condiciones rígidas, la vía de 

señalización de EGF logra promover la proliferación en hepatocitos, así como se demostró en los 

trabajos realizados por Kenny et al., (2018). 
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8. CONCLUSIONES  

En los cultivos primarios de hepatocitos se demostró que la mecánica, mediada por el módulo de 

elasticidad o rigidez, y la variación de la composición de proteínas de MEC influyen 

evidentemente en el esparcimiento, agregación y supervivencia de los hepatocitos. En este 

sentido, los hepatocitos cultivados en los hidrogeles de PA de 20 kPa en todas las condiciones, 

después de las 72 h, presentaron una adherencia total al sustrato, morfología totalmente 

transformada de tipo mesenquimal similar a fenotipo de fibroblasto, y una mayor área de 

esparcimiento celular y nuclear con respecto a los cultivados a 1 kPa en 24 y 72 h. Sin embargo, 

en condiciones suaves, los hepatocitos mostraron mayor sobrevivencia y una preferencia de 

adhesión a los sustratos que contenían cualquiera de las concentraciones de Col I (100, 75 y 50%); 

en contraste, los hidrogeles de MB y de MECd 2 h, al parecer no presentaron las condiciones 

ideales para la adhesión y sobrevivencia de los hepatocitos, debido a que se presentó la formación 

de cuerpos apoptóticos y células no adheridas al sustrato.  

Por otro lado, el estímulo con EGF solamente logró rescatar la viabilidad en las células cultivadas 

en hidrogeles con MECd 2 h; aunque como se mencionó, es necesario realizar más investigación 

para el entendimiento de este efecto únicamente en esta condición. Con respecto a la 

proliferación, EGF no logró promover este efecto en las células cultivadas sobre los hidrogeles 

que contenían Col I y MECd 48 h, pero sí generó un aumento en el número y tamaño de agregados 

celulares en las condiciones suaves.  

En este trabajo de investigación, de manera interesante, se reveló que los hepatocitos se adhieren 

preferentemente a los hidrogeles que contienen cualquiera de las concentraciones de Col I, pero 

no en los sustratos que contienen proteínas de MECd, como se hipotetizaba inicialmente. Estos 

resultados sugieren que el colágeno fibrilar juega un papel importante en la adherencia y 

sobrevivencia de hepatocitos. No obstante, a pesar de que diversos grupos de investigación han 

logrado resultados prometedores con el uso de proteínas de MEC de hígados descelularizados 

como excelentes sistemas biomiméticos para el cultivo de hepatocitos, todavía es necesario 

profundizar en las investigaciones para encontrar la fracción ideal de proteínas de MECd y, 

posiblemente, en combinación con otras proteínas generar plataformas de cultivo que 
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promuevan la adherencia celular y mantengan el fenotipo de los hepatocitos en un tiempo más 

prolongado. 
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9. PERSPECTIVAS 

1. Detectar y caracterizar la presencia de otros colágenos fibrilares en las fracciones de MECd 

digeridas a 2 y 48 h, así como en otras digeridas a distintos tiempos.  

2. Evaluar la capacidad de adhesión celular de las fracciones de MECd digeridas a otros 

tiempos, sobre los sustratos de hidrogel de rigidez variable.  

3. Identificar y cuantificar la composición de péptidos de las fracciones de MECd 

solubilizadas con pepsina, por medio de técnicas analíticas.  

4. Probar otras combinaciones de proteínas fibrilares con proteínas de MECd, para observar 

un posible sinergismo que permita mimetizar el microambiente hepático en andamios 

celulares.  
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10. ANEXOS 

10.1 Anexo I 

10.1.1 Protocolos de tinción para geles SDS-PAGE 

 Tinción con Azul de Coomassie R250 

1. Se elaboraron geles de poliacrilamida 8% (por cada 2 geles) con base a las siguientes 

relaciones: 

Tabla 2. Soluciones para la elaboración de geles SDS-PAGE 

 

 

 

 

 

 

 

 

2. Las mezclas de cada uno de los tipos de geles se colocaron en los mini plates de la cámara de 

electroforesis para la polimerización de ambos. Una vez gelificados, se colocaron las muestras 

de proteínas solubilizadas en tampón de Laemmli 2X, según la concentración requerida. 

3. Las proteínas se separaron a 120 V durante ~1.5 h. 

4.  Los geles se incubaron por 1.5 h o durante toda la noche en la solución de tinción que 

contenía 0.25 g de Azul brillante de Coomassie R250 en 90 mL de 1:1 v/v metanol/agua y 10 

mL de ácido acético glacial. 

Gel separador (Resolving gel) 8% 

Componente Volumen (mL) 

  

Agua desionizada 9.3 

30% Mix Acrilamida/Bis 5.3 

1.5 M Buffer Tris, pH 8.8 5.0 

10% SDS 0.2 

10% Persulfato de amonio (APS) 0.2 

Tetrametiletilendiamina (TEMED) 0.012 

Gel Concentrador (Stacking gel) 5% 

Agua desionizada 5.5 

30% Mix Acrilamida/Bis 1.3 

1.0 M Buffer Tris, pH 6.8 1.0 

10% SDS 0.08 

10% Persulfato de amonio (APS) 0.80 

Tetrametiletilendiamina (TEMED) 0.008 
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5. Se realizaron lavados con la solución desteñidora que contenía 450 mL de 1:1 v/v 

metanol/agua y 50 mL de ácido acético glacial, y se dejaron incubar por periodos de 2 a 3 h 

hasta observar la visualización de las bandas de proteínas.  

6. Finalmente, los geles se guardaron en agua a 4°C para su posterior análisis.  

 

 Tinción con nitrato de plata para geles SDS-PAGE 8% 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.  Todas las soluciones se prepararon en el mismo día de su aplicación, tomando en 

consideración que por cada gel se requerían aproximadamente 50 mL de las siguientes 

soluciones: 

2. Se incubaron los geles en la solución de fijación por al menos 2.5 h y se realizaron lavados 

con agua destilada por 2 min, luego se lavaron 3 veces con metanol al 50% por 10 min 

cada uno y finalmente se enjuagaron con agua destilada por 2 min. 

Tabla 3. Soluciones para tinción con nitrato de plata 

Solución Componentes 

Fijación 

Para 100 mL: 

50% Metanol absoluto 

12% Ácido acético glacial 

0.5% Formaldehído 37% 

Agua destilada hasta ajustar volumen 

Oxidación 

Por litro: 

0.2 g de Na2S2O3 • 5 H2O / L 

Agua destilada hasta ajustar volumen 

Impregnación 

Por litro: 

2 g de AgNO3 

7.5 mL Formaldehído 37% 

Agua destilada hasta ajustar volumen 

Revelado 

Por litro: 

60 g de Na2CO3 / L 

4 mg de Na2S2O3 • 5 H2O / L 

5 mL Formaldehído 37% 

Ajustar el volumen con agua destilada 
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3. Los geles se incubaron en la solución de oxidación por 35 s. En seguida, se realizaron 3 

lavados con agua destilada por 20 s en cada paso.  

4. Posteriormente, se prosiguió con la incubación con la solución de impregnación por 3 min, 

seguido de lavados con agua destilada durante 20 s, 2 veces.  

5. Se agregó la solución de revelado (aproximadamente por 5 s) hasta notar la tinción de las 

bandas de proteínas. En este paso, se tuvo la precaución de no sobrepasar el tiempo con 

la solución, ya que existe el riesgo de teñir en exceso los geles de poliacrilamida y generar 

un contraste o background inadecuado.  

6. Una vez terminado el revelado, se lavaron inmediatamente 2 veces con agua destilada 

durante 1 min y en seguida, se agregó solución de fijación durante 10 min para detener la 

reacción de revelado. 

7. Finalmente, se realizaron lavados con agua destilada y se guardaron a 4°C. 
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10.2 Anexo II 

10.2.1 Protocolo de Western blot 

A continuación, en la Tabla 4 se presentan las soluciones utilizadas durante la técnica de Western 

blot o inmunoblot: 

Tabla 4. Soluciones para la técnica de Western blot 

Solución Composición 

Buffer de transferencia 1X 

25 mM Tris-base 

192 mM Glicina 

10% Metanol absoluto 

Ajustar volumen a 1 L con agua desionizada 

Tris-buffer salino (TBS) 10X 

200 mM Tris-base 

1.5 M NaCl 

Ajustar volumen a 1 L con agua desionizada  

Ajustar pH 7.6 con HCl 12 N 

Tris-buffer salino (TBS) 1X 

20 mM Tris-base 

150 mM NaCl 

Ajustar volumen a 1 L con agua desionizada  

Ajustar pH 7.6 con HCl 12 N 

Tris-buffer salino con Tween-20 (TBST) 1X 

20 mM Tris-base 

150 mM NaCl 

0.1% Tween-20 

Ajustar volumen a 1 L con agua desionizada  

Ajustar pH 7.6 con HCl 12 N 

 

1. Primeramente, se realizaron geles SDS-PAGE con proteínas de MEC digeridas a los tiempos 

establecidos previamente, junto con las proteínas control. 

2. Una vez separadas las proteínas, se seleccionaron fragmentos de membranas de PVDF y en 

un contenedor fueron hidratadas con metanol absoluto por 3 min y se lavaron 2 veces con 

buffer de transferencia 1X para eliminar el exceso de metanol.  
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NOTA: Para la manipulación de las membranas, es importante emplear pinzas y evitar que 

tenga contacto con las manos o guantes, ya que estos pueden contener restos de proteínas 

propias del usuario, que podrían transferirse a las membranas e interferir con los resultados.  

3. Luego, se prosiguió con la transferencia de las proteínas de los geles SDS-PAGE a las 

membrana de PVDF, colocando capas de esponjas, papel filtro, membranas y geles SDS-

PAGE, en tipo sandwich sobre los cassettes de la cámara de transferencia, tal como se 

muestra en la Figura 15.   

En este paso debe asegurarse mantener la hidratación de todos los materiales del sandwich, 

con buffer de transferencia.  

NOTA: Un punto importante durante la colocación de las membranas sobre los geles, es 

retirar cualquier burbuja generada para evitar una inadecuada transferencia de las proteínas. 

Esto se puede realizar deslizando el largo de una pipeta sobre la membrana, hasta observar 

que se hayan eliminado todas las burbujas.  

 

 

 

 

 

 

 

 

 

 

4. Los cassettes se colocaron dentro de la cámara con la orientación de cátodo a ánodo, 

cuidando de mantener la presión sobre los mismos; en seguida, se agregó buffer de 

transferencia 1X hasta cubrir aproximadamente donde se sitúan los geles y las proteínas se 

transfirieron a 320 mA (constante) durante 2.5 h.  

Figura 15. Componentes para la transferencia de proteínas en el Western Blot.  



 
 

 72 

5. Terminada la transferencia, las membranas se incubaron en solución de bloqueo (compuesto 

de suero de leche al 5% baja en grasa, en solución de TBST 1X), durante 1 h en agitación, para 

reducir propiamente los sitios de unión inespecíficos al anticuerpo.  

En caso de que hubiesen dos membranas en un mismo contenedor, se debe tener cuidado 

que los lados donde se encuentren las proteínas no estén en contacto y que estas sean 

deslizables mientras están en agitación.  

6. Finalizado el bloqueo, se realizaron 3 lavados con agua desionizada y finalmente un lavado 

con TBST 1X por unos segundos.  

7. En bolsas de plástico se colocaron las membranas y con un sellador se ajustó herméticamente 

al tamaño de la membrana. Al instante, se agregó la solución de anticuerpos primarios con la 

dilución requerida en aproximadamente 5 mL de TBST 1X, se retiraron restos de burbujas y 

finalmente, las bolsas se sellaron completamente para dejar incubando durante toda la 

noche a 4°C, en agitación. 

8. Después de la incubación con los anticuerpos, se realizaron 3 lavados con TBST 1X durante 

10 min en cada paso.  

9. Luego, se continuó con la incubación de los anticuerpos secundarios conjugados con 

peroxidasa de rábano (HRP) a la dilución requerida en TBST 1X durante 1 h en agitación, a 

temperatura ambiente. En seguida, se realizaron 3 lavados con TBST 1X durante 5 min cada 

uno.  

10. En otro contenedor, se agregó 1 mL del sustrato contra la enzima peroxidasa y 1 mL de 

luminol (ambos, considerados una unidad) en 4 mL de agua desionizada para que fuese una 

dilución 1:3. Esta dilución puede variar en función de la intensidad de señal que se cree 

considerada dependiendo de la concentración de anticuerpo primario añadido. A 

continuación, se colocó la membrana en la solución y se dejó incubar por 1 min. En este lapso, 

se preparó nuevamente otra bolsa de plástico a la medida de la membrana para que esta 

pudiera ser colocada dentro de ella, y a su vez, en la cámara de exposición.  

 

11. Previo a este paso, se prepararon las soluciones de revelado, de fijación y agua, en charolas.  
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12. Posteriormente, bajo condiciones de oscuridad o con luz roja, se cortaron fragmentos de 

películas de rayos X y se colocaron sobre las membranas a distintos tiempos de exposición 

para ver cuál era el ideal para la detección de las proteínas.  

13. Al instante, las películas se colocaron en la solución reveladora hasta observar la presencia 

de las proteínas. Una vez detectadas, se retiró el exceso de solución lavando con agua y en 

seguida se colocaron en la solución de fijación.  

14. Después del revelado, todas las películas se lavaron con abundante agua corriente y se 

dejaron secar. 
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10.3 Anexo III 

10.3.1 Elaboración de hidrogeles de poliacrilamida para cultivo celular 

Para la elaboración de hidrogeles de poliacrilamida con rigidez controlable, se empleó el siguiente 

protocolo con base a Tse y Engler., 2010 y Cretu et al., 2010: 

1. Funcionalización de cubreobjetos: 

a. Se colocaron cubreobjetos, de manera ordenada, en una caja Petri de 10 cm de diámetro 

cubierta con parafilm y a cada uno se agregó 1 mL de NaOH 0.1 M, dejando incubar 

durante 3 min, a temperatura ambiente. Enseguida, se retiró la solución con una pipeta 

acoplada a una línea de vacío. 

b. En campana de extracción, se agregó 300 µL de APTES a cada cubreobjetos, durante 3 min 

a temperatura ambiente e inmediatamente se retiró. Los residuos fueron vertidos en su 

contenedor de desechos correspondiente.   

c. Luego, se retiró el exceso de APTES con un lavado inmediato con 20 mL de agua 

desionizada a todos los cubreobjetos contenidos en la caja Petri y enseguida se vertió en 

su contenedor de desechos. Este paso fue repetido 2 veces. 

d. Posteriormente, cada cubreobjetos fue lavado individualmente 3 veces con agua 

desionizada y, con ayuda de una pinzas, estos fueron transferidos a otra caja Petri cubierta 

con parafilm. En este procedimiento se tuvo la precaución que el lado del cubreobjetos 

donde se realizaron los tratamientos anteriores, quedara con la orientación hacia arriba.   

e. Después, los cubreobjetos se lavaron 3 veces con agua desionizada en agitación durante 

10 min, cada uno a temperatura ambiente.  

f. Finalizando los lavados, el agua se desechó, se retiró el excedente del líquido con toallas 

de papel absorbentes y se dejaron secar.  

g. En campana de extracción, se agregó 1 mL de una solución 0.5% v/v de glutaraldehído a 

cada cubreobjetos, durante 30 min a temperatura ambiente.  

h. Se retiró el glutaraldehído con el sistema de vacío y nuevamente se repitió el inciso e.  

i. Los cubreobjetos se dejaron secar completamente y se almacenaron en una caja Petri 

cubierta con parafilm, a temperatura ambiente, libre de humedad, hasta su posterior uso. 
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En este paso se tuvo la precaución de mantener consciente la orientación del cubreobjetos 

con la superficie tratada. 

2. Silanización de portaobjetos: 

j. Primeramente, los portaobjetos se limpiaron cuidadosamente con etanol o isopropanol y 

se colocaron dentro de un recipiente. Luego, en campana de extracción, se agregaron 100 

µL de DCDMS (diclorodimetilsilano) a cada portaobjeto, hasta asegurarse de cubrir toda 

la superficie.  

k. El DCDMS se incubó por 5 min y el excedente se retiró con papel absorbente. Finalmente, 

los portaobjetos se almacenaron en recipientes con su etiquetado correspondiente.  

3. Elaboración de hidrogeles de poliacrilamida: 

l. En un microtubo de 1.5 mL se prepararon 900 µL las soluciones de 40 % acrilamida y 2% 

bis-acrilamida con las proporciones correspondientes en función a la rigidez requerida con 

base a la Tabla 5. La proporción de cada uno de los componentes fueron considerados 

para preparar 1 mL de volumen final. Posteriormente, se agregaron 10% APS y 1% TEMED. 

m. En los portaobjetos silanizados se colocaron 100 µL de la mezcla de hidrogel de 

acrilamida/bis-acrilamida y en seguida se colocaron los cubreobjetos con la superficie 

funcionalizada sobre la gota hasta que ésta estuviera esparcida completamente sin formar 

burbujas o espacio vacíos. Luego, los hidrogeles se dejaron polimerizar por al menos 30 

min a temperatura ambiente. 

n. Una vez polimerizados los hidrogeles, con el apoyo de unas pinzas o aguja de jeringa, se 

retiraron los cubreobjetos cuidadosamente del portaobjetos, evitando dañar o fracturar 

los hidrogeles. 

o. Finalmente, los hidrogeles (con orientación hacia el lado superior) fueron colocados en 

cajas de poliestireno de 12 pozos, se lavaron 3 veces con PBS 1X en agitación durante 5 

min cada uno y se almacenaron en agua desionizada hasta su posterior uso.  
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4. Entrecruzamiento de proteína por método entrecruzante: 

p. Se prepararon mezclas de proteínas de colágena tipo I de cola de rata, Matrigel®, 

colágena/Matrigel® y péptidos de MECd de 2 y 48 h, y posteriormente se les añadió NHS-

éster acrilato [1.7 mg/mL] e Irgacure® 2949 [11 mg/mL]. 

q. Se utilizaron 0.1 mg/mL de cada una de las mezclas de proteínas para conjugarse con los 

hidrogeles y éstos se entrecruzaron mediante la exposición de luz ultravioleta (365 nm) y 

una potencia nominal de 3.3 mW/cm2, durante 3 min en una cámara reticulante UVP CL-

1000L. 

r. Los hidrogeles de poliacrilamida con las proteínas conjugadas se almacenaron en cajas de 

cultivo celular de 12 pozos hasta su posterior uso.  
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Tabla 5. Módulo de elasticidad esperado después de la polimerización de las concentraciones 

relativas de acrilamida y bis-acrilamida (Tse y Engler, 2010). 
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10.4 Anexo IV 

10.4 Protocolo de cuantificación celular en el software Fiji-ImageJ 

1. Calibración de escala 

a. Antes de iniciar un análisis de cuantificación celular, es primordial calibrar la escala en 

función de la magnificación u objetivo con que fueron capturadas las imágenes de 

microscopía. Para ello, primeramente en el software ImageJ, seleccionar (File → Open) 

una imagen de microscopía con escala o regla integrada y en la barra de herramientas, 

seleccionar la recta straight y dibujar la línea sobre la longitud de la regla. 

b. Seleccionar la línea dibujada y en Analyze → Measure observar su longitud en pixeles. 

Este paso puede realizarse al menos 3 veces para cerciorarse de una medición exacta.  

c. Posteriormente, dar clic en Analyze → Set scale y en Distance in pixels insertar el 

promedio de las mediciones (en pixeles) realizadas previamente. Luego, insertar la 

distancia conocida (known distance) de la recta y las unidades en la que se encuentra 

(Unit of length). 

Por ejemplo, para una imagen de un objetivo 20x, si la recta dibujada corresponde a 500 

µm (know distance) y su distancia en pixeles (Distance in pixels) es 1597, entonces la 

escala automática ajustada correspondería a 3.194 pixeles/µm.  

d. Finalmente, seleccionar Global si la escala será utilizada para un conjunto de imágenes 

obtenidas con el mismo objetivo y luego dar clic en OK. 

 

2. Cuantificación de área de células individuales 

e. Primeramente, en File → Open seleccionar la imagen de microscopía a cuantificar.  

f. Las células individuales son consideradas aquellas que se encuentran totalmente 

separadas del resto (únicamente solas en el campo; pueden ser binucleadas) o dos células 

muy juntas. De este modo, en la barra de herramientas, en función de la geometría de la 

célula, seleccionar la opción de polígono (polygon) o elipse (oval). En seguida, hacer Zoom 

a la imagen (Image → Zoom →In [+]) y delimitar los contornos célula por célula. 

g. Después de delimitar el contorno una célula, presionar la tecla t para añadir el elemento 

a la ventana de ROI Manager.  
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h. Finalizando la selección total de las células, dar clic en Measure del ROI Manager y en 

seguida, aparecerá la ventana de resultados (Results) con las áreas de cada una de las 

células.  

i. En la ventana de Results, guardar los datos en File → Save as → *nombre del archivo.csv 

o .xls* 

j. En la ventana de ROI Manager, seleccionar todos los elementos y luego dar clic en More>> 

→ Save… → *nombre del archivo*. 

 

 

3. Cuantificación de área nuclear en imágenes de fluorescencia con DAPI 

k. Seleccionar la imagen que se desea analizar (File → Open) y transformarla a formato de 8 

bits (Image → Type → 8bit). 

l. Duplicar la imagen (Ctrl + Shift + D) y de preferencia guardarla con el nombre que sugiere 

por default.  

m. Para disminuir un poco el ruido que llegase a tener la imagen, seleccionar el filtro Gaussian 

(Process → Filters → Gaussian Blur) y asignarle un Sigma (Radius) de 0.2 y dar clic en OK. 

n. Invertir la imagen (Edit → Invert). 

o. Ajustar el contraste en la ventana B&C (Ctrl + Shift + C) y dar clic en AUTO. 

p. Ajustar los límites de partículas con el Threshold (Image → Adjust → Threshold), 

seleccionar tipo Huang, Red y ajustar los límites y relleno deslizando la segunda barra 

(primeramente a la izquierda y poco a poco a la derecha hasta llegar al ajuste deseado). 

Asegurase que la mayor parte de las partículas queden con forma definida, con bordes 

regulares y con el menor ruido posible en los alrededores.  

Finalmente, dar clic en Apply. 

q. Para rellenar completamente las partículas seleccionar Process → Binary → Fill Holes. 

Para dividir algunas partículas ‘pegadas’, seleccionar Process → Binary → Watershed.  

r. Confirmar la calibración de la escala de pixeles a micrómetros (Analyze → Set Scale).  

s. Realizar el análisis de partículas (Analyze → Analyze Particles) definiendo el rango de 

tamaño requerido y seleccionando la información que queremos que nos proporcione. 

Dar clic en OK. 
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t. En seguida aparecerán las ventanas de Results, Summary y ROI Manager. Minimizar todas 

las ventanas excepto ROI Manager y la imagen original (inicialmente convertida a 8 bits). 

En la ventana de ROI Manager dar doble clic en Show All para que tome en cuenta ahora 

los parámetros asignados sobre la imagen original.  

u. Realizar Zoom a la imagen y de manera manual, descartar las partículas que fueron 

tomadas en cuenta pero que están fuera de los parámetros asignados o no tienen una 

forma definida (seleccionarlas con la herramienta *Oval o elipse* y dar clic en Delete del 

ROI Manager); por el contrario, seleccionar la Herramienta *Oval o elipse* para 

seleccionar una partícula que no fue considerada y queremos que se agregue a la lista del 

ROI Manager. Una vez seleccionada la partícula en la imagen, dar clic en Add o presionar 

la letra t.  

v. Una vez definidas todas las partículas a analizar, en la ventana de Results, seleccionar 

todos los elementos (Edit → Select All) y eliminarlos (Edit → Clear). 

w. En la ventana del ROI Manager, seleccionar todos los elementos (Clic en el primer 

elemento → Shift + Fin) y dar clic en Measure, así la lista de Results se actualizará con 

base a las últimas modificaciones realizadas.  

x. Guardar la información de Results (File → Save As) en formato de hoja de cálculo (.xls o 

.csv) y de ROI Manager (Seleccionar todo → More → Save…) en el formato por default. 

 

4. Cuantificación de área de agregados celulares y número de células por agregado 

y. En File → Open seleccionar la imagen de microscopía a cuantificar. 

z. Los criterios que se consideran como agregados celulares son aquellos que son un grupo 

mayor a 3 células, agrupaciones redondas (no alargadas) y áreas mayores a 2500 µm. Con 

base a ello, en la barra de herramientas seleccionar Polygon y delimitar los contornos de 

los aglomerados de las células, de acuerdo a las especificaciones mencionadas 

anteriormente.  

aa. Una vez marcado el contorno del aglomerado, presionar la tecla t para añadir el elemento 

al ROI Manager. 
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bb. Finalizando la selección de todos los agregados, dar clic en Measure del ROI Manager y a 

continuación, aparecerá la ventana de Results. Analizar los valores de cada una de las 

áreas resultantes y eliminar (Edit → Cut) aquellos que se encuentren menor a 2500 µm. 

cc. Finalmente, guardar los datos de Results y ROI Manager como previamente se ha 

mencionado.  

dd. El conteo de células por aglomerado se realizó de modo manual, almacenando los datos 

en hojas de cálculo para ser analizados posteriormente.  
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